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Introduction

Welcome to the CIM GOLD® User's Guide. This documentation provides a brief overview of the Customer
Information Management program and explains basic ideas and features. 

CIM GOLD combines all your customers' account information into a complete, easy-to-use system on your PC.
CIM GOLD shows all accounts, including deposit and loan accounts, ATM and debit cards, tax filings, and more
that are tied to your customers. This system makes it easy to look up accounts without having to open the
Loan, Deposit, and other subsystems individually. 

With CIM GOLD, you can create follow-up assignments for employees to complete, such as soliciting
customers for loans and calling customers on their birthdays. You can also create comments and messages
tied to account holders that track important information about that customer. And CIM GOLD is customizable,
so your institution can choose the screens and functions you want to use.

Field-Level Help and Master Help on CIM GOLD Screens
For detailed information on using each screen and field in CIM GOLD, click on any field and press <F1> to read
the help for that field. 

You can also search for terms using the CIM GOLD Master help file. See the Master Help topic for more
information.

Regular or Enhanced Mode (Tiles)
You can use CIM GOLD in regular mode or enhanced user mode. With the enhanced mode, you can click on
tiles to quickly jump to often-used screens.
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Overview
CIM GOLD offers convenience and adaptability to your institution's individual needs.

CIM GOLD includes the following features:
· A tree-like navigation. You can also search for a screen by its name.
· Optional tiles for quick access to often-used screens.
· You can choose which screens your institution uses.
· You can send lists of data to Report Manager or export data to a tab-delimited file you can later open in

programs such as Microsoft® Excel.
· You can interrupt work to process a customer.
· Screens that combine data from several sources to eliminate jumping from screen to screen.
· You can create comments tied to the customer, not accounts.
· You can create comments for follow-up activity.
· You can pop out a screen and look at other screens at the same time.

CIM GOLD also offers a customer information system called CIS that can help you build customer relationships
and implement your relationship banking policies. CIS is integrated with all FPS GOLD systems, including
deposits, new accounts, loan origination, loan servicing, Internet banking, and others, to provide a powerful
customer summary for all employees to successfully deal with each customer. 

Using CIS, bank employees can quickly identify the monetary value or the potential value of a customer based
on accounts the customer owns and accounts the customer influences (customer relationships). 

When new relationships are discovered, they can be quickly and easily added to CIS. Once added, all bank
employees can immediately view the new relationships. 

For a detailed guide to CIS, see the CIS User's Guide on DocsOnWeb.

Basic Concepts

This section defines basic terms and concepts essential to CIM GOLD. 

Afterhours Processing

The term "afterhours" refers to the processing that occurs during the night. This processing includes such
things as printing reports, statements, and notices. Afterhours processing is done automatically by FPS
GOLD programs. 

File Maintenance

The term "file maintenance" (commonly abbreviated as "F/M") is found in various places in CIM GOLD. It is
also found in the Security Setup. File maintenance means users can change information in fields. Some
fields allow file maintenance, and some do not. Additionally, security can be set up for individual fields and
screens for file maintenance or inquiry-only access. Inquiry-only access means users can only view
information; they cannot change it.

Each <F1> field help topic states whether that field is file maintainable or not, as shown in the following
example:

https://secure.fps-gold.com/docsOnWeb/uguides/CIS/ucs.htm
https://secure.fps-gold.com/docsOnWeb/uguides/CIS/ucs.htm
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F/M: No means file maintenance is not allowed.

F/M: Yes means file maintenance is allowed. 

Field

A field is simply a place for data on the screen. You can enter or view information in fields, as shown in the
following example:

Mnemonic

A mnemonic is a five-character name for a field. Mnemonics make it possible for you to build specialized
reports. Not all fields have mnemonics. The <F1> help and the Tooltip pop-up will tell you which fields have
mnemonics and which fields do not. If a field does not have a mnemonic, the information in that field cannot
be included on a report.

For more information on mnemonics and how to use them in reports, see Section 1.1, Mnemonics in the
Report Writer documentation in DocsOnWeb. 

List View

A list view is a table of information. Many screens in CIM GOLD have list views. You can sort the
information in the columns from descending to ascending or vice versa by clicking on the column header.
Each list view also has right-click functionality. See the following example of the list view on the Amortizing
Fees Screen:

https://secure.fps-gold.com/docsOnWeb/other/ReportWriter/orw1s1.htm?zoom_highlight=mnemonic


Overview8

© 2024 DHI Computing Service, Inc.Last updated: 9/9/2024

List Icon

For many fields in CIM GOLD, you click a list icon  to view and select a list of possible entries for that
field. The options on these lists are entered by FPS GOLD or by someone at your institution who sets up
information using the System Setup Screens.

The following is an example of a list that appears after a user clicks the list icon:

Drop-Down Field

Some fields on CIM GOLD screens are referred to as drop-down fields. Drop-down fields are similar to list
icons, except that you open the list by clicking on an arrow in the field, as shown in the following example.
FPS GOLD controls the information in these lists.
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General Information

As you are entering information or updating information, there are a few things to be aware of.

Read Screens

Make it a habit to read your screens thoroughly. Many of the screens have specific directions listed on
them that are not included in this user guide. They are self explanatory and very useful. 

Also, many fields on screens have an error provider icon ( ). Watch for these icons to know which fields
are mandatory, or to view any additional messages that may accompany that field. If this icon appears on
any field on a screen, you will not be able to save data changes until the error provider is removed by
entering the appropriate data.

Entering Dollar and Rate Amounts

The system automatically enters dollars and decimals in appropriate fields. Generally, you will not need to
enter a decimal point or a comma when entering this type of information in CIM GOLD. However, you can
also manually enter a decimal, and when you navigate away from the field, the system will automatically
place the appropriate amount of zeroes on the end based on the number of digits in the field after the
decimal.

Clicking <Save Changes>

Clicking <Save Changes> processes any new or changed data in the fields on the screen. It is important to
click <Save Changes> after making any correction, change, addition, or deletion in a field. However, when
you have several changes on a screen or are entering data on a new screen, you can enter all necessary
changes or new data, then click <Save Changes> to process all of the changes at the same time.

Making Corrections

If you have already clicked <Save Changes> to process changes you have made on a screen, you can still
make a correction to that entry. Simply type over the same field with the correct information, then click
<Save Changes> again. If you need to make a change to information that can only be changed or corrected
with a transaction (such as Principal Balance or Account Balance), use CIM GOLDTeller. Most monetary
fields are not maintainable.
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Default Fields

Some of the fields on the various screens are default fields. If a default field does not have information
entered in it, the system will enter the default information into the field from other sources, such as from
institution options, setup files, etc. Some of these fields will display with default information already entered.
If they contain the correct information, leave them as they are. If you need to change the default information,
type the correct data over the default data, then click <Save Changes>.

Security

Your designated security officer should have set up a user name for you. If not, contact your security officer.
You cannot open any FPS GOLD applications without a user name and security code.

In addition, your security officer can decide which screens you can use and which fields on screens you can
file maintain. For example, if your job does not require data entry of any kind, you may only have access to
inquiry mode functions, which you can only use to view information. If your job deals specifically with loans,
you may only have access to the Loan system and those systems associated with it, such as CIS.

For more information about how to set up security features, see the Security section under Setting Up CIM
GOLD in this user guide.

Security Violations

The system will give you three tries to enter a correct user name and security code. If, after three attempts,
you have not entered a valid security code, the system will lock you out. If this occurs, contact your
security officer to have your violation reset.
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Keystrokes

In addition to Windows standard keystrokes, FPS GOLD has a number of keystrokes that are standard
throughout different applications and programs. Some are only available in CIM GOLD. 

The following is a list of FPS GOLD keystrokes and their functions that are standard throughout different
applications and programs. 

Keystroke Function

<Enter>
Transmits information to the host computer.

<Tab> Moves cursor forward to the next open field.

<Alt> + <Tab> Toggles among open applications in Windows.

<Ctrl> +
<Tab>

Toggles among open windows in an application.

<Shift> +
<Tab>

Moves cursor backward, field to field.

<F1> Opens the Help window.

<Alt> + <F4> Closes CIM GOLD.

<Ctrl> +
<Shift> + <P>

Opens the Print dialog box so you can print the screen being
displayed to the printer you select.

<Alt> Turns on access keys. Access keys appear under the menu bar as a
way to quickly access menu functions. 

When you press <Alt> in CIM GOLD, a line will appear under a letter
in each menu that uses access keys. Then press <Shift> plus the
applicable underlined letter to open that particular menu. This is the
same as using the mouse to click on the menu. For example, <Shift>
+ F will open the File menu when "F" is underlined.

You can also also set up speed keys in CIM GOLD.

· You can jump to screens with one keystroke when you link them to speed keys <F2>, <F3>, <F4>,
<F5>, <F6>, <F7>, <F8>, and <F9>.

· In CIM GOLD, you choose which speed keys you will use.
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Setting Up Security
Before a user can open CIM GOLD, security must be set up for each employee who needs it. This section
contains details on setting up security for CIM GOLD.

See the following topics:

Company Options Screen
Subscribe to Mini-Applications Screen
Reset Violations Screen
Security Setup Screen
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Company Options Screen
Security > Company Options

Overview of Security

Before using CIM GOLD and other FPS GOLD product applications, security must be set up for your institution
and its employees. The CIM GOLD Security screens are used to set up the following:

· Company security options
· Security for employees and tellers
· Security for CIM GOLD screens
· Security for system screens such as GOLDTeller and GOLDView
· CIM GOLD Field Level Security 

The following list specifies the order in which security must be set up within CIM GOLD so that security will
work properly for your institution and employees. 

1. Subscribe to Mini-Applications - Your institution must subscribe to all applications and screens your
institution will have access to before you can set up security. 

2. Company Options - The options on this screen let you define your institution name, length of employee
numbers and passwords, days to force security code (password) changes, and minutes of inactivity to time
out CIM GOLD and other FPS GOLD products. Company Options are found on the CIM GOLD Security >
Company Options screen.

3. Setup - Contains setup fields for employee, profile, teller security, CIM GOLD screens, system screens,
and Field Level Security. If your institution chooses to use profiles, they must be set up before setting up
individual employees.

Some of the features available in the CIM GOLD Security system are listed below. 

· You can create profile groups to set up employees with similar security clearance. For example, all tellers
could be set up with the same security access.

· You can set up multiple profiles per employee.
· You can specify a length of time after which password changes are forced.
· Users can select their own security codes (passwords).
· You can grant users one of three levels of security: File Maintenance, Inquiry, and None (no access). 
· You can set the length of time an FPS GOLD program can remain inactive before automatically locking

the program and requiring a password to be entered.
· You can grant specified FPS GOLD customer service employees defined levels of security access.
· You can delete security for terminated employees.
· You can delete unused profiles.
· Reports for changes made to the Security System are FPSDR218, Security Change Report, and Online

Report.

Setting Up Company Options

To set up your company's security options:

1. Enter your institution name in the Institution Name field.
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2. In the Employee Number Length field, enter a number between 4 to 10. (For example, if you enter 8 here,
all employee numbers must be eight digits long.)

3. In the Days to Force Employee Password Change field, enter a number between 15 and 99 (or 9999,
never expires) to define the default number of days between forced password changes for your institution.
The recommendation is to force a password change at least every 90 days. This company default can be
overridden during individual employee setup.

Password changes are forced after the specified length of time. This feature protects your institution from
fraudulent use of a security code for any extended period. Should a security code be violated, the user could
immediately create a new security code. If the violation goes undetected, the violated code is only usable
until the Days to Force Employee Password Change days are reached. 

4. In the Minutes Without Activity to Close Terminal field, enter the number of minutes for your institution’s
default that will trigger a timeout for users. A minimum of 5 and maximum of 60 minutes must be entered;
the system will not accept a number outside that range. This company default can be overridden during
individual employee setup.

The first time a user attempts to enter anything on an FPS GOLD screen after the timeout value has
expired, a timeout window will be displayed, and the user must enter their user name and password in order
to continue. 

This feature, also called an "inactivity logoff," increases security by locking FPS GOLD programs that are
not in "active" use. 

5. In the Minimum Length of Password (security code) field, enter the minimum password (security code)
length for your institution’s default, a minimum of 5 and maximum of 40. If a number outside this range is
entered, the following error message will appear: "PASSWORD value must be from 5 to 8." If employees
attempt to set passwords (security codes) with fewer characters than the minimum you specify in this field,
they will receive the following error: "PASSWORD IS NOT LONG ENOUGH OR INVALID SPACES IN
PASSWORD." 

6. If left blank, the Customer Service Security field will allow all FPS GOLD support employees access to
your institution files. A check mark will turn on the customer service security option, and you are given the
option to select the security access granted for FPS customer service employees. You must select the
FPS GOLD support employees from the Customer Service list; only those selected will be able to access
and support your institution.

7. If you check the Force Alpha-Numeric Passwords field, all employees must use both letters and numbers
in their passwords (security codes). If the field is left blank, employees can enter any variation of letters
and/or numbers they want without restrictions.

8. When the Force Special Characters in Passwords field is checked, all employees will be required to
have at least one special character in their passwords (security code). If the field is left blank, special
characters will not be required in passwords. 

For user names and passwords, all printable characters and embedded spaces are now allowed. (See the
table below.)user names are not case sensitive. Passwords are case sensitive. Leading and trailing spaces
will be ignored. 
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Characters Allowed in Passwords and User Names

Alphanumeric characters abcdefghijklmnopqrstuvwxyz 
ABCDEFGHIJKLMNOPQRSTUVWXYZ 
1234567890

Special characters  - = , . / \ ! @ # $ %  ̂& * ( ) _ + < > ? : ” { } | [ ] ; ’

9. User Defined Fields are designated fields tied to each employee’s security setup that can be used for any
purpose within an institution. For example, an institution could set up a field to show the title of the
employee, date of hire, birth date, etc. 

10. For each User Defined Field implemented, enter the Data Type (Numeric or Alpha-Numeric), field Length,
and Field Description. Each user-defined field set up at an institution will show on the Employee setup
tab. 

WARNING

Once the User Defined Fields are set up, they cannot be
removed or changed.

The reset password function is located in CIM GOLD Security > Reset Password. When an employee cannot
remember their password, the security administrator can reset the password to the employee's user name. The
employee would then log in using their user name as a password. The employee will then be prompted to
provide a new password. If a user has violated a terminal by entering the password incorrectly three times and
can't remember the password, first reset the violated terminal, and then reset the employee password. FPS
GOLD recommends that only a limited number of employees be given the ability to reset passwords.

To reset a password, click on the employee's name in the list and click <Reset Password>, then click <Yes>
on the Verify Action dialog box. 

Only one employee can be reset at a time. Once the password has been reset, an employee has 12 hours to
sign on using their user name as the password. At then next logon, the employee will be required to set a new
password.
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Setting Passwords

For new employees, the password (security code) for their first sign-on will be the same as their assigned user
name, and they will be forced to change them. The password they choose will be ruled based on the setup
password fields in the Company Options menu. The password will automatically expire after the designated time
selected to force an employee password change at your institution. 

On the day the password is forced to change, the employee will log on to the system as usual and enter their
current password. The program will then generate a Password Change dialog box that will prompt the employee
to enter a new password (twice). A passwords can only be changed after the correct current code has been
entered.

The system keeps track of the last five passwords for each user name. You cannot reuse a previously used
password until at least five new passwords have been used. On the sixth password change, you are able to
reuse the first password that was used.

If, at any time, you want to change your password, log on as you normally would. Enter your User Name,
current Security Code (password), mark the Change Security Code (password) box, and click <OK>. The
recommendation is for an employee to change their security code if they suspect that their password has been
compromised. 
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The system will display a Password Change dialog box asking you for the new password (security code).

When changing a password, the system requires the user to enter the new code twice. This is to verify that the
user entered the new password correctly.

See Also:

Rules for Valid Passwords

 

Rules for Valid Passwords
For user names and passwords, all printable characters and embedded spaces are allowed. (See the table
below.)user names are not case sensitive. Passwords are case sensitive. Leading and trailing spaces will be
ignored. 

Characters Allowed in Passwords and User Names

Alphanumeric characters abcdefghijklmnopqrstuvwxyz 
ABCDEFGHIJKLMNOPQRSTUVWXYZ 

1234567890

Special characters  - = , . / \ ! @ # $ %  ̂& * ( ) _ + < > ? : ” { } | [ ] ; ’

Types of Passwords Not Allowed
The following table lists the kinds of passwords that are not valid. Based on the settings on the Company
Options screen, users will have to follow these rules when creating passwords.
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Password Length A Password Is Not Valid If . . . 

Any length · The new password is the same as the current password or any of the last 4
previous passwords (regardless of case).

· The Force Special Characters in Passwords field is checked and the new
password doesn’t contain a special character.

· The Force Alpha-Numeric Passwords field is checked and the new password
doesn’t contain at least one number and one letter.

· The new password is shorter than the value in the Minimum Length of
Password field.

· The new password is empty.
· The new password has ascending or descending sequences (sequences are

found by splitting the password with a blank space). For example, "12 cba" is not
valid, but "12 abc" is.

More than 8
characters

· The new password contains the user name (regardless of case).
· The new password has a sequence of 5 or more consecutive ascending or

descending characters. For example, “LONGabcdePASSWORD” and
“LONG54321PASSWORD” are not valid, but “LONGabcdPASSWORD” is valid.

· The new password has 4 or more consecutive identical characters. For example,
“long 1111 password” is not valid.

8 characters or less · The password is fewer than 5 characters.
· There are 3 or more characters that are the same as the last non-blank

character. For example, “11121” is not valid.
· There are 4 or more characters that are the same as the first non-blank character.

For example "1211118" is not valid.
· Characters 1-4 are the same as 5-8, or 2-4 are the same as 5-7, or 3-5 are the

same as 6-8, or 1-3 are the same as 4-6. For example “abcdabcd” is not valid.
· There are more than 3 blank characters in the password.
· See "Characters Allowed in Passwords" above.

Institution Name

Enter your Institution name in this field.

Employee Number Length

Enter the number of digits allowed in an employee number. The length can range from four to 10 digits and
cannot be changed once it is set.

Days to Force Employee Password Change

Enter a number between 15 and 9999 that defines the number of days between forced password changes for
employees at your institution. 9999 means the password will never expire.

Password changes are forced after the specified length of time. This feature protects your institution from
fraudulent use of a security code for any extended period. Should a security code be violated, the user could
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immediately assign themselves a new security code. If the violation goes undetected, the violated code is only
usable until the Days to Force Employee Password Change days are reached. 

If you change the value in this field, the change is applied to all new employees added after the change. To
change the password expiration deadline for your current employees, use the Password Expiration field on the
Security > Setup screen, Employee tab for each employee. 

Minutes Without Activity to Close Terminal

Enter the default number of minutes for your institution that will trigger a timeout for users. A minimum of 5 and
maximum of 60 minutes must be entered; the system will not accept a number outside that range. The default
is 20 minutes.

The first time a user attempts to enter anything on an FPS GOLD screen after the timeout value has expired, a
timeout window will be displayed, and the user must enter their user name and password in order to continue. 

This feature, also called an "inactivity logoff," increases security by locking FPS GOLD programs that are not in
"active" use. Should a user need more or less time before timeout occurs, the security officer can override the
default and enter any length of time up to 546 minutes on the Employee Definition screen.

Minimum Length of Password (5-40)

Enter the minimum password (security code) length for your institution’s default, a minimum of 5 and maximum
of 40. If employees attempt to set passwords (security codes) with fewer characters than the minimum you
specify in this field, they will receive the following error: "PASSWORD IS NOT LONG ENOUGH OR INVALID
SPACES IN PASSWORD." 

User-Selected Security Code
On the day security codes are forced to change, employees will log on to the system as normal and enter their
old security codes. The computer will then ask them to enter a new security code (twice). Security codes can
be changed only after the correct current security code has been entered.

The system keeps track of the last six security codes for each user name. You cannot reuse a previously used
security code until at least six new security codes have been used. On the seventh time, you are allowed to
reuse the old security code.

If at any time you want to change your security number, log on as you normally would. Enter all of the
information you normally would as you sign on, except click the Change Security Code box. The system will
display a dialog box asking you for the new security code.

When changing a security code, the system requires the user to enter the code twice. The reason for this is to
verify that the user did in fact enter the number he or she wanted. One typo could cause a lot of confusion.

See Also:

Rules for Valid Passwords
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Customer Service Security

If this field is left blank, all FPS GOLD support employees can access your institution files. A check mark will
turn on the Customer Service Security option, and you will need to select the security access you want to grant
for specific FPS customer service employees on the Customer Service tab. Only those selected will be able to
access your files.

FPS GOLD Only: NCC Security employees can add an FPS GOLD employee to the list with proper
authorization.

Force Alpha-Numeric Passwords

If you check this box, all employees must use both letters and numbers in their passwords (security codes). If
the field is left blank, employees can enter any combination of letters and numbers without restrictions.

User-Selected Security Code
On the day security codes are forced to change, employees will log on to the system as normal and enter their
old security codes. The computer will then ask them to enter a new security code (twice). Security codes can
be changed only after the correct current security code has been entered.

The system keeps track of the last six security codes for each user name. You cannot reuse a previously used
security code until at least six new security codes have been used. On the seventh time, you are allowed to
reuse the old security code.

If at any time you want to change your security number, log on as you normally would. Enter all of the
information you normally would as you sign on, except click the Change Security Code box. The system will
display a dialog box asking you for the new security code.

When changing a security code, the system requires the user to enter the code twice. The reason for this is to
verify that the user did in fact enter the number wanted. One typo could cause a lot of confusion.

See Also:

Rules for Valid Passwords

Force Special Characters in Passwords

When this field is checked, all employees will be required to have at least one special character in their
passwords (security code). If the field is left blank, special characters will not be required in passwords. 

User-Selected Security Code
On the day security codes are forced to change, employees will log on to the system as normal and enter their
old security codes. The computer will then ask them to enter a new security code (twice). Security codes can
be changed only after the correct current security code has been entered.
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The system keeps track of the last six security codes for each user name. You cannot reuse a previously used
security code until at least six new security codes have been used. On the seventh time, you are able to reuse
the old security code.

If at any time you want to change your security number, log on as you normally would. Enter all of the
information you normally would as you sign on, except click the Change Security Code box. The system will
display a dialog box asking you for the new security code.

When changing a security code, the system requires the user to enter the code twice. The reason for this is to
verify that the user did in fact enter the number he or she wanted. One typo could cause a lot of confusion.

See Also:

Rules for Valid Passwords

User Defined Fields field group
User Defined Fields are designated fields tied to each employee’s security setup that can be used for any
purpose within an institution. For example, an institution could set up a field to show the title of the employee,
date of hire, birth dates, etc. 

For each User Defined Field implemented, enter the Data Type (Numeric or Alpha-Numeric), field Length, and
Field Description. Each User Defined field set up at an institution will show on the Employee setup tab. 

WARNING

Once the User Defined Fields are set up, they cannot be
removed or changed.

See the following topics:

User Defined Field Type 1 - 5
User Defined Field Length 1 - 5
User Defined Field Description 1 - 5

User Defined Field Type 1 - 5

User-defined fields are designated fields tied to each employee’s security setup that can be used for any
purpose within an institution. For example, an institution could set up a field to show the title of the employee,
date of hire, birth dates, etc. 

For each User-defined field implemented, enter the Data Type (Numeric or Alpha-Numeric), field Length, and
Field Description. Each User Defined field set up at an institution will show on the Employee setup tab. 
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WARNING

Once the User Defined Fields are set up, they cannot be
removed or changed.

User Defined Field Length 1 - 5

User-defined fields are designated fields tied to each employee’s security setup that can be used for any
purpose within an institution. For example, an institution could set up a field to show the title of the employee,
date of hire, birth dates, etc. 

For each User-defined field implemented, enter the Data Type (Numeric or Alpha-Numeric), field Length, and
Field Description. Each User Defined field set up at an institution will show on the Employee setup tab. 

WARNING

Once the User Defined Fields are set up, they cannot be
removed or changed.

User Defined Field Description 1 -  5

User-defined fields are designated fields tied to each employee’s security setup that can be used for any
purpose within an institution. For example, an institution could set up a field to show the title of the employee,
date of hire, birth dates, etc. 

For each User-defined field implemented, enter the Data Type (Numeric or Alpha-Numeric), field Length, and
Field Description. Each User Defined field set up at an institution will show on the Employee setup tab. 

WARNING

Once the User Defined Fields are set up, they cannot be
removed or changed.
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Subscribe to Mini-Applications Screen
Security > Subscribe to Mini-Applications

The Subscribe to Mini-Applications screen allows you to designate which applications and screens your
institution will have access to in CIM GOLD. If a screen is not subscribed to, it will not be listed on the CIM
GOLD Subscribe to Mini-Applications screen to give security access to. You must have proper security to
access this screen. 

The screens are listed in alphabetical order, which is the same way they appear in the CIM GOLD navigation
tree. Please be aware that some applications and screens may have a billable fee for their use. You can see
which screens are billable by clicking on a screen listed on the Subscribe to Mini-Applications screen; the price
for using that screen will appear in the Cost per Month per User field at the bottom of the screen. The
Description field will provide a short description of the application or screen selected. 

Most screens can be unsubscribed to if you uncheck the box next to the screen. When unsubscribing to a
screen, all security given to employees and CIM GOLD Profiles for that screen will be deleted. Use caution
when unsubscribing to a screen; if a screen is unsubscribed to in error, all employees and CIM GOLD Profiles
will need to be set up for security to the screen again. If a screen is required and cannot be unsubscribed to,
you will get an error if you uncheck the box.

NOTE

Employees already signed on to the system can view a newly
subscribed screen by deleting their cache. If they wait until the
following day, they will be able to view the screen on their first
sign on. 

The list view displays all screens available to your institution. To subscribe to any screen, check the box next to
it. The Description field gives a short description of the highlighted screen. The Cost per Month per User field
shows the cost, if any, of the highlighted screen each month for each person using it.

After selecting all the screens you want to subscribe to, click <Save Changes>.

NOTE

Your institution must subscribe to a screen before that screen
will appear in Security Setup or in the CIM GOLD navigation
tree for any user. As new screens are added to the list, they
are advertised in a release notification.

Unsubscribing
To unsubscribe from a screen, remove the check in its box by clicking on it. If you unsubscribe to any screen,
you will see a warning when you click <Save Changes>: "Warning! You are unsubscribing to at least one mini-
application. This action will remove all security to these mini-applications for every person and every profile! Do
you REALLY want to continue?" Click <Yes> to continue or <No> to cancel and return to the screen.

See also:
Security Setup System
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Screens List View

This list view displays all screens available to your institution. To subscribe to any screen, check the box next
to it. After selecting all the screens you want to subscribe to, click <Save Changes>.

Description

This field gives a short description of the highlighted screen.

Cost per Month per User

This field shows the cost, if any, of the highlighted screen each month for each person using it.
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Reset Violations Screen
Security > Reset Violations

The Reset Violations screen is located in CIM GOLD Security > Reset Violations. Use this screen to reset a
password if one of the following occurs:

· the user has entered an incorrect password three consecutive times while attempting to log in;
· the user has been inactive for 90 days or more.

A user cannot sign on to any FPS GOLD product until the violation has been cleared. FPS GOLD recommends
that only a limited number of employees be given security to reset violated terminals. 

NOTE

FPS GOLD cannot reset security violations for your
employees. An employee at your institution must reset them.

If there are no security violations when you open the Reset Violations screen, you will see the message “There
are no violations to display” in a red box at the top of the screen. See the following example.

FPS GOLD ONLY

Editor users do not have security to this function.

Reset Violations Screen without a Violation

 
If there are security violations, they will be listed on the screen. See the following example.
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Reset Violations Screen with a Violation

To clear a violation:

1. Highlight the name in the list.
2. Click the <Reset> button on the bottom of the screen. 

The reset will clear the violation, and the user can attempt to log in again with their current password. 

Changing a Password
Resetting violations does not change the password to the user name. A password is only reset to the user
name by resetting the password on the Employee screen in Security Setup or on the Reset Passwords screen.
Use this method if a user forgets his or her password. 

Setting Timed Logoff
The Security > Company Options screen contains a field called Minutes Without Activity to Close Terminal.
Each institution can set this field for any given employee to a number of minutes. When that amount of time has
passed without any activity, the system automatically logs the employee off the terminal. That employee must
then sign on to the system again following the normal procedure.

Number

This field displays the teller number for the user who caused the violation. 

For instructions on how to use this screen, see the overview topic.

Name

This field displays the name of the employee with the security violation.

User Name

This field displays the user name of the user who caused the violation. This field is used on CIM GOLD screens
and afterhours reports.

For instructions on how to use this screen, see the overview topic.
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Enhanced User Name

This field displays the long user name (if your institution has entered this data) for the employee with the
violation. 

This name is only used in security. The User Name field is used on CIM GOLD screens and afterhours reports.

Location

This field displays the PC VTAM location for the user with the violation. 

For instructions on how to use this screen, see the overview topic.
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Security Setup Screen
Before you can use CIM GOLD, each employee who will use CIM GOLD must have security to the screens or
specific fields they will use. 

 

NOTE

FPS GOLD must add security for your institution’s Security
Administrator before employee security setups can begin.
Some security settings can only be changed by a Security
Administrator.

 Overview of CIM GOLD Security

Security for CIM GOLD is set up on several CIM GOLD screens. The following list shows the order in which
security must be set up within CIM GOLD so that security will work properly for your institution and employees. 

1. Subscribe to Mini-Applications - Before security setup, your institution must subscribe to all applications
and screens your institution will use.

2. Company Options - The fields on this screen define your institution name, length of employee numbers
and passwords, days to force security code (password) changes, and minutes of inactivity to timeout CIM
GOLD and other FPS GOLD products. Company Options are found on the CIM GOLD Security > Company
Options screen.

3. Institution defaults for CIM GOLD Customer Index Bubble, CIM GOLDTeller (for Menu and Speed Keys), and
Document Imaging (for Firebird Signatures). 

4. Security > Setup - Contains setup fields for employee, profile, teller security, CIM GOLD screens, and
field-level security. If your institution chooses to use profiles, they must be set up before setting up individual
employees.

What Is a Security Profile?

On the CIM GOLD Profile tab and System Profile tab, you can set up security profiles. Profiles save time and
ensure that security settings are the same for all employees with the same duties (such as all tellers or all loan
officers). A profile is set up one time and then linked to all employees that require the same security access.
For example, the security access for all tellers could be set up under the profile name “Teller.” The “Teller” profile
would then be linked to each employee who requires access to the security given under the “Teller” profile. 

Profiles save time because you set up security only once for a group of employees that would require the same
security clearance. Also, if a security change is needed for a group of employees that share the same profile,
you can change the security one time on the profile, rather than changing each individual employee’s security. 

NOTE

FPS GOLD client services representatives have inquiry-access
only to institution security. We cannot release password
violations or reset passwords for your institution at any time.
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An employee at your institution must handle these types of
security issues.

Using the Security Setup Screen

Use the Security Setup screen to assign screen-level or field-level security to individual employees and tellers.
You can also create security profiles for groups (such as the loan department) and then assign individual
employees to those groups. All individuals assigned to the same group profile will then have the same security
settings.

Note: This section gives overviews and how-to information on using Security Setup. For help on an individual
field on the Security Setup screen, click in the field and press the <F1> key on your keyboard.

This section describes how to set up:

· Company Security options,

Employee tab
Use the fields on the Employee tab of the Security > Setup screen to set up employee security.

NOTE

FPS GOLD cannot reset passwords or security violations for
your employees.

Setting Up an Employee

To set up security for an employee, create a new employee. You can also copy security to a new employee or
from one existing employee to another.

To create a new employee:

1. On the Security Setup screen, select Employees and click <New>.
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Security Setup Screen, Employee Tab

2. In the "Create a new Employee" dialog box, type a new Employee Number, User Name, Enhanced User
Name, and Full Name. The fields on the dialog box are explained in the table below.

NOTE

After you click <OK>, you cannot change the Employee
Number for this employee. You can only delete this employee
and start over. To do this, change the employee Status to
"Terminated" and delete the employee using the Terminated
Employee Deletion screen. 

Field Name Number of Characters Purpose Editable?

Employee Number variable—established on
the Company Options
screen

identify the employee
within the organization

No. See the Note above.
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User Name maximum of eight
alphanumeric characters

shown on reports and
screens

Yes, if Display Effective
Security is not checked

Enhanced User Name up to 40 characters used to log on to FPS
GOLD products

Yes

3. Click <OK>. 

4. On the Employee tab, enter the remaining data. The Status drop-down list will show the default “Active”
status. Select another status if necessary.

5. An Interface Profile is used to determine the settings an employee should use for the following three
functions: CIM GOLD Customer Index Bubble, Menus and Speed Keys in CIM GOLDTeller, and Document
Imaging (for Firebird Signatures). 

6. Timeout Minutes are defaulted from the Company Options screen. If the length of time is not appropriate
for the new employee, you can enter 5 to 60 minutes.

7. Password Expiration is defaulted from the Company Options screen. If an employee needs more or fewer
days between password (security code) changes, enter a number between 15 and 99 here. You can also
enter 9999 for a password that never expires.

8. SoftToken Key is a two-step authentication that can be used in EFT GOLD for wires for added security. If
your institution has selected Require SoftToken Authentication on the EFT GOLD Wire Options screen,
enter the appropriate information in this field. For more information on using this feature, see the EFT GOLD
User's Guide in DocsOnWeb.

9. If this employee will use a System Profile, select the appropriate profile(s) from the list below by checking
the box in the Member? column.

10. If this employee will use a CIM GOLD Profile, select the appropriate profile(s) from the list below by
checking the box in the Member? column.

CIM GOLD and System Profiles must be set up before you can use the profile name on an employee
security setup.

11. Enter the appropriate information in the User Defined fields that your organization may have set up on the
Company Options screen.

12. Click <Save Changes>.

If the employee being set up is also a teller, continue to the Teller tab. If the employee is not a teller and is not
using CIM GOLD or System Profiles, go to the CIM GOLD and System tabs to set the appropriate security.

<Reset Password> This button should only be used when employees forget their passwords. Clicking this
button gives employees 12 hours to enter their user name as their password before the system will force them
to create a new password. Giving employees security to the Reset Password mini-application allows them to
reset passwords but does not allow them to change any security. The temporary password will be the same as
the Enhanced User Name in lower case.

For example, John Doe’s user name is JOHND. He would enter “JOHND” in the User Name field and "johnd" as
the password. When he clicks <OK>, a Security Code Update window will display. To save the new code, John
Doe would then enter a new password in the Enter New Password and Re-enter New Password fields and
click <OK>. 

https://secure.fps-gold.com/docsOnWeb/uguides/EFTGOLD/ueg.htm
https://secure.fps-gold.com/docsOnWeb/uguides/EFTGOLD/ueg.htm
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If a password is changed using this method, the password will remain valid until the next Password Expiration
interval is reached or the employee forces a password change when logging in to CIM GOLD.

To copy employee security to a new employee:

1. If the Display Effective Security box has a checkmark, click on it to remove it.
2. Select the employee in the list, then click <Copy to New> to copy the security settings from the selected

employee to a new employee. All the security, including profiles, will be copied to the new employee. (This
does not copy Teller information.)

3. Make any adjustments to the new employee's individual security as needed.
4. Click <Save Changes>.

To copy security from one existing employee to another:

1. If the Display Effective Security box has a checkmark, click on it to remove it.
2. Select the employee you will copy from in the list, then click <Copy to Existing>. 
       The "Select Existing Employee to Copy to" dialog box opens.

3. In the dialog box, select the employee you want to copy to. 
All the security, including profiles, will be replaced for the employee you are copying to. (This does not copy
Teller information.)

4. Make any adjustments to the new employee's individual security as needed.
5. Click <Save Changes>.

Deleting an Employee

You can't use the <Delete> button on this screen to remove an employee from the system. This prevents you
from accidentally deleting an employee.
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To delete an employee:

1. Select "Terminated" from the Status drop-down list.
2. Open the Security > Terminated Employee Deletion screen and delete them from the system.

See Also:
CIM GOLD Profile tab 
System Profile tab
CIM GOLD tab

CIM GOLD Profile tab
Use the fields on this tab to set up CIM GOLD profiles. Any CIM GOLD profiles that already exist on the system
will be shown in the list view. 

For information on how profiles work and why they are useful, see "What Is a Security Profile?" in the Security
Setup Screen overview section. 

Creating a CIM GOLD Profile

You can copy from an existing profile or create a new one. 

To create a CIM GOLD profile:

1. On the Security Setup screen, select   and click <New>. 

2. In the "Create a CIM GOLD Profile" dialog box, type a new Profile Name and click <OK>. CIM GOLD
Profile names can have up to 12 characters.

3. The new Profile Name will be added to the bottom of the profile list with the default “Active” Status. The new
profile name will also be added to the CIM GOLD Profile Membership list on the Employee setup tab and
can be selected for employees that will be tied to a profile.

4. On the CIM GOLD tab, select all applications and screens the profile will need to use, then click <Save
Changes>. The Search field allows you to enter data to find the security setting. If found in the main heading
list, the main heading is highlighted. See the example below.
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5. If you use field-level security restrictions, open the Field Level tab, select restrictions for the profile, then
click <Save Changes>.
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Copying a CIM GOLD Profile

To copy a profile:

1. Select a CIM GOLD profile from the list.
2. Click <Copy> to copy the security settings from an existing CIM GOLD profile to a new one. 
3. Make any necessary adjustments to the new profile.
4. Click <Save Changes>.

Deleting a CIM GOLD Profile

To delete a profile:

1. Make sure the profile is not attached to any employees. Otherwise, you will get an error message that tells
you employees are assigned to it.

2. Select the CIM GOLD profile and click <Delete>.

See Also:
Employee tab
System Profile tab
CIM GOLD tab

System Profile tab
Use the fields on this tab to set up security for all FPS GOLD products not listed on the CIM GOLD tab. Only
employees with proper security (such as a Security Administrator) can set up system profiles.

For information on how profiles work and why they are useful, see "What Is a Security Profile?" in the Security
Setup Screen overview section. 

Creating a System Profile

You can copy from an existing profile or create a new one. 

To create a System profile:

1. On the Security Setup screen, select System Profiles, then click <New>.
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2. In the Create a new Profile dialog box, enter the appropriate information in the fields (see the example
below). FPS GOLD recommends that you designate an employee number range to use for System , such as
9900–9989. The name assigned to the profile will be listed in the System Profile drop-down list on the
Employee setup tab and can be selected for employees that will be tied to a profile. A System Legacy
Name can have up to eight characters. It cannot be the same as any other profile or user name. The 
Profile Name and Profile Description can be up to 40 characters long and can be used to further define
the profile. When you have finished entering information, click <OK>.

The new profile will be shown in the profile list with the default “Active” Status.

3. On the System tab, select all functions the profile will need to use, then click <Save Changes>.

After profiles have been set up, create individual employee security on the Employee tab, and tie each employee
setup to the appropriate profiles.

Copying a System Profile

To copy a profile:

1. Select a System profile from the list.
2. Click <Copy to New> to copy the security settings from an existing System profile to a new one. 
      or
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Click <Copy to Existing> to copy the security settings from one existing System profile to another. 
3. Make any necessary adjustments to the new profile.
4. Click <Save Changes>.

Deleting a System Profile

To delete a profile:

1. Make sure the profile is not attached to an employees. Otherwise, you will get an error message that tells
you employees are assigned to it.

2. Open the Security > Terminated Employee Deletion screen and delete the profile.
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EFT GOLD Security Groups

Add employees to EFT GOLD security profiles based on the actions they need to perform in EFT GOLD. The
actions and functions the profiles control in EFT GOLD are explained below.

IMPORTANT

The predefined System Profiles used for EFT GOLD should not
be changed in any way. If they are changed, your user security
functions will not work.

Within EFT GOLD, the security groups are found under Administrative Options > Users/Groups. The example
below is sorted alphabetically. Your profile numbers and descriptions may not match these.

Predefined EFT GOLD User Profiles

WireAdminSecurityGroup
The users in this group have access to all Admin functions except Users. The menu items secured by this
option are found on the menu under Management, Options, Custom Rules, Alerts, OFAC Whitelist, and System
Logs.

WireCanOverrideTransactions
Users in this group can approve wires but not OFAC suspects. Dual control is used, so approvers cannot
approve their own submitted wires. The user's limits are used when this action is processed.

WireMessageReaderGroup
Users in this group can view FRB wire messages. "FRB Messages/View FRB Messages" is found on the menu.

Click  to open the menu.

WireMessageUpdaterGroup
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Users in this group can create and send FRB messages. If you can create and send messages, you can also
view them if you do not remove WireMessageUpdaterGroup from the WireMessageReaderGroup.

"FRB Messages/View FRB Messages" is found on the menu. Click  to open the menu.

WireOfacApproverGroup
Users in this group can approve OFAC suspects, but not wires.

WireOfacWhitelistUpdaterGroup
Users in this group can approve OFAC suspects and add names to your Whitelist.

WireUserAdminSecurityGroup
The users in this group have access to Users functions on the menu under Admin > Users. 

WireUserSecurityGroup
Every user that is going to access anything in EFT GOLD needs to be in this group. The billing for EFT GOLD is
based on the users with this security.

WireViewFrbBalanceSecurityGroup
Users in this group can view your institution's FRB balance on the Dashboard. Without this security, the user
cannot see the balance information.

GOLDDeploy Security Groups/Profiles

The predefined System Profiles used for GOLDDeploy should not be changed in any way. If they are, your user
security functions will not work. Add employees to these profiles based on the actions they need to perform in
GOLDDeploy. The actions and functions the profiles control in GOLDDeploy are explained below.

DeployAdministrator

The users in this group have access to design parameters and options for deployment of FPS GOLD® software
to your users. Users in this group are administrators, deployers, and viewers. They don't need any other security
settings.

Deployer
The users in this group have access to schedule and deploy FPS GOLD software releases to your users. Users
in this group can also view all screens.

DeployUser
The users in this group can only view the schedules and options that are set up but cannot make changes.

See Also:
Employee tab
CIM GOLD Profile tab 
CIM GOLD tab

CIM GOLD tab
Use the fields on the CIM GOLD tab of the Security > Setup screen to set up CIM GOLD security for your
employees. Some CIM GOLD applications also require some security settings on the System tab. CIM GOLD
security is used for the screens; System security is used for functions within the screens and for financial
applications.
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Setting Up CIM GOLD Security

Before any employee can access CIM GOLD, security clearance must be set up for that employee. CIM GOLD
security can be set up on individual employees and/or on  . The profiles can be tied to employees who require
the same security clearance to perform their job duties. If multiple profiles are tied to an employee, Effective
Security can be viewed.

To set up CIM GOLD access for an employee or profile:

1. On the Security Setup screen, select Employees or CIM GOLD Profiles. 

2. Select the CIM GOLD tab.

3. In the Security Setup list view, select the employee or CIM GOLD Profile for which security is being set
up or changed.

4. Select Inquire or Maintain on each item listed below the applications to which the employee or CIM GOLD
Profile should have access. If no access is allowed, select None.

NOTE

If you want employees to have security to change User Preferences
under the Options menu at the top of the CIM GOLD screen, you
must select "Maintain" for the first item, [Customer Search Screen],
on the CIM GOLD tab. See the example below.
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5. When you have finished making selections, click <Save Changes>.

See Also:
Employee tab
CIM GOLD Profile tab 
System Profile tab

System tab
Use the fields on the System tab on the Security > Setup screen to set up security for all other FPS GOLD
products not listed on the CIM GOLD tab for your employees. Some CIM GOLD applications also require some
security settings on the System tab. CIM GOLD security is used for the screens; System security is used for
functions within the screens and for financial applications.

Setting Up System Security

The System tab is used to set up security for employees and profiles that need to have access to all other FPS
GOLD programs that are not listed on the CIM GOLD tab. The System tab will be disabled if you have not
selected Employees or System Profiles. 

Many of the applications listed on the System security tab are obsolete and have been programmed to be used
in CIM GOLD, such as GOLD ExceptionManager and IRS GOLD. However, you must select the Maintain radio
button for the FPS PC Applications function on the System tab to grant access to CIM GOLD. There are also
other functions in PC Applications which can control access to CIS, employee and officer names, as well as
other PC applications. Obsolete menus have been removed from this documentation.

Applications and functions are listed in alphabetic order. Set each option for access for each employee or
profile. 

To set up System security:

1. On the Security > Setup screen, select either the Employees or System Profiles radio button.
2. In the list view on the left side of the screen, select the employee or profile you want to set up.
3. Select the System tab, as shown below.
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3. Select Inquire or Maintain on each item listed below applications to which the employee or profile should
have access. If no access is allowed, select None. "Inquire" means the employee can view information on
the screen but cannot change it. "Maintain" means an employee can view and change information on the
screen.

4. When you have finished making selections, click <Save Changes>.

For a list of all security options on this tab and a short description, see System Security Details.

See Also:
Employee tab
CIM GOLD Profile tab 
System Profile tab

System Security Details

The following tables list all possible security options on the System tab of the Security > Setup screen. Only
specific security personnel at your institution can set up these screens for employees. These options affect
which applications employees have access to, as well as other features and functions within applications.
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Account Merchant List - OBSOLETE

Accounting Report Writer

Accounts Payable

Accounts Receivable - OBSOLETE

Additional Loan Security - OBSOLETE

Allow Customer Support Access

Alter Terminal for Payroll

Commercial Loan Menu - OBSOLETE

Core File Synchronization

Core Tools

Customer Information File - OBSOLETE

Deposit Document Prep System - OBSOLETE

Deposit System - OBSOLETE

Electronic Teller Journal - OBSOLETE

Event Letter Parameters - OBSOLETE

Financial Options

Fixed Assets

FPS PC Applications

Fps-Change Terminal Options - OBSOLETE

Funds Distribution - OBSOLETE

General Institution Options

General Ledger System

GL GOLD

GOLD ExceptionManager

GOLD Miner Downloads

GOLDPhone Processing - OBSOLETE

GOLD Services

GOLDTeller Security

GOLDTrak Loan Tracking System

GOLDView

GOLDView 32

Item Posting Rejects - OBSOLETE

Loan System - OBSOLETE

Materials Management - OBSOLETE
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Office Management - OBSOLETE

Old Office Management System - OBSOLETE

Organization Options - OBSOLETE

Payroll Management

PC Check Image Utilities

Prrpts0 - OBSOLETE

Report Warehouse Menu

Report Writer - OBSOLETE

Reports and Dacosys Options

Security Management

System Print Program

Utility Programs - OBSOLETE

Web Security

Accounting Report Writer - Application 50

Bit # Function Name Function

03 Dictionary

01 Run Reports

02 Set Up Reports

Accounts Payable - Application 7

Bit # Function Name Function

15 **DROP 6,10

17 **DROP Function
OBSOLETE

36 Ach Invoice Verification 16

39 Ach Pmt Threshold
Verification

16

30 Capital Approval

06 Cash Planning 4

18 Category Codes

61 Change Client Number 66

12 Check Reconciliation 32

05 Check Register 27

27 Contract File

38 Control Statement Register 43
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Accounts Payable - Application 7

14 Dist. Screen Formats 9/10

10 Distribution Profile 5/6

31 Emp. Code in Responsibility

04 Flag Invoices for Payment 8, 12, 15

22 Inventory Product

23 Inventory Product Spcl
Changes

08 Invoice Payee 30

24 Item Profiles

28 Location Profiles

29 Multiple File Changes 1-6 / 2-6

62 Only Post To Term Table
Office

30, 34

09 Post Recurring Payments 34

03 Print Checks 20

3 Print Control Statements 36

02 Print Reports

26 Print Requests 1-5 / 2-5, 15

13 Recurring Payments 13/14

01 Report Formats 59-2

16 Report Writer 63

20 Responsibility File 1-3 / 2-3

33 Restrict Detail Fields 18, 30

64 Run Report Writer Reports 63-1, 63-7

25 Screen Formats

63 Set Up Report Writer
Reports

63-2, 63-3, 63-4, 63-6

19 Ship To Locations 1-1 / 2-1

07 Transaction Processing 29/30

32 Vendor Alternate Payee 2-4, 18

21 Vendor File 1-4 / 2-4, 17/18

35 Vendor Master Ach Screen 17/18, <F2>

11 Void Checks 24

37 Void Control Statements 40
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Accounts Receivable - OBSOLETE

Additional Loan Security - OBSOLETE

Allow Customer Support Access  - Application 30

Bit
#

Function Name Function

01 Allow Customer Support
Access

Alter Terminal for Payroll  - Application 30

Bit
#

Function Name Function

01 Access Alter terminal institution and office number

Commercial Loan Menu - OBSOLETE

Core File Synchronization

Bit
#

Function Name Function

01 Download Security

Core Tools

Bit
#

Function Name Function

01 Access

Customer Information File - OBSOLETE

 

Deposit Document Prep System - Application 4 - OBSOLETE

Deposit System - Application 4 - OBSOLETE

Electronic Teller Journal - OBSOLETE

Event Letter Parameters - OBSOLETE
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Financial Options - Application 18

Bit
#

Function Name Function

16 Account Number Structure

05 Accounts Payable

06 Accounts Receivable 13/14

01 Company Name/Accounting
Prds

3/4

Financial Options

Financial Routing Info Rec

04 Inventory

07 Payroll Options 15/16

03 Requisition/Purchase Order

Fixed Assets - Application 33

Bit
#

Function Name Functions

01 Access to Program Gives access to the Fixed Assets system (Application 33) in
GOLDVision.

04 Change Client Number To access clients other than 0 (zero) in the Fixed Assets system, the
Maintain radio button must be selected for this option. This is mainly
for FPS GOLD use.

05 Distribution Profiles (F8)  

63 Report Writer Report Setup 63-2, 63-3, 63-4, 63-6

64 Report Writer Run Report 63-1, 63-7

FPS PC Applications - Application 57

Bit
#

Function Name Function

01 Access to PC Applications WinTerm, GOLDTeller, GOLDPrint, GOLDView, G/L GOLD,
GOLDVision, GOLDWriter, GOLD ExceptionManager, GOLDAcquire,
CIM GOLD, IRS GOLD

40 Allow Gateway to Alter
Terminal

GOLDGateway

41 Chat/remote = F.Remote = I Access to use chat and remote override

19 CheckWriter Change/add
Checks

CheckWriter

22 CheckWriter Change/add
Docs

CheckWriter

https://secure.goldpointsystems.com/gpsdocs/accounting/FixedAssets/afa.asp
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FPS PC Applications - Application 57

18 CheckWriter List Checks CheckWriter

21 CheckWriter List Docs CheckWriter

20 CheckWriter Print Checks CheckWriter

27 CIM Can See Employee Dep
Accounts

CIM GOLD

38 CIM Can See Employee Dep
History

CIM GOLD

33 CIM Can See Employee Ln
Accounts

CIM GOLD

39 CIM Can See Employee Ln
History

CIM GOLD

42 CIM GOLD Document Imaging CIM GOLD

24 CIM Security Setup CIM GOLD

26 CIM Subscription Setup CIM GOLD

25 CIM User Defined Help Setup CIM GOLD

02 CIS Access to Emp/offcr
Name

CIS (in CIM GOLD)

29 EFTGOLD Access EFT GOLD

31 EFTGOLD Approve Wires EFT GOLD

32 EFTGOLD Change Options EFT GOLD

30 EFTGOLD Submit Wires EFT GOLD

36 EFTGOLD View Inbound
Wires

EFT GOLD

37 EFTGOLD View Outbound
Wires

EFT GOLD

28 EFTGOLD Wire Limits EFT GOLD

23 Eis/dsr Email Setup Executive Reports

50 File Services Access Settings File Services Plus

46 File Services Attach Files File Services Plus

47 File Services Delete Files File Services Plus

52 File Services Edit Metadata File Services Plus

51 File Services Export Files File Services Plus

53 File Services F/M Cache
Folder

File Services Plus

49 File Services Stats / History File Services Plus

48 File Services Transfer Files File Services Plus
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FPS PC Applications - Application 57

45 File Services Utility Access File Services Plus

34 GOLDAcquire Access GOLDAcquire

35 GOLDAcquire Upload GOLDAcquire

44 GOLDEventLetters Access GOLD EventLetters

43 GOLDLink Skip / Delete Loan GOLDLink

11 GOLDWriter Access GOLDWriter

05 Imaging Acquire From
Scanner

GOLDDocument Imaging

14 Imaging Change Group GOLDDocument Imaging

15 Imaging Change Subgroup GOLDDocument Imaging

03 Imaging Create Database GOLDDocument Imaging

12 Imaging Create Group GOLDDocument Imaging

13 Imaging Create Subgroup GOLDDocument Imaging

09 Imaging Delete Images GOLDDocument Imaging

16 Imaging Export Images GOLDDocument Imaging

07 Imaging Import Images GOLDDocument Imaging

08 Imaging Modify Image Info GOLDDocument Imaging

04 Imaging Open Database GOLDDocument Imaging

10 Imaging Print GOLDDocument Imaging

17 Imaging Properties GOLDDocument Imaging

6 Imaging Select Scanning
Source

GOLDDocument Imaging

55 Pci Card Vault

54 View Entire Card Number

Fps-Change Terminal Options - Application 24 - OBSOLETE

General Institution Options

Bit
#

Function Name Functions

01 Access

02 Batch Reports Fiche/print

09 External G/L Posting Setup

06 General Ledger Autopost
Setup
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General Institution Options

08 General Ledger Cross
Reference

11 Ledgers Control

12 Ledgers Defaults

10 Make an Available Account

03 Print Batch Reports Options

07 Print G/L Autopost
Parameters

13 Rate Tiers Processing

05 Rates Tables Processing

04 Teller Information Processing

General Ledger System - Application 1

Bit
#

Function Name Functions

13 Account Budget F/M 53/54, 57/58

26 Account Defaults 79/80

03 Account File Maintenance 53/54, 57/58

16 Account Number Structure 5/6

29 Allow Acct Drop with
Bal/Trans

54, 58

30 Allow G/L Sweeps 95/96, 99

15 Budget Rec
Disp/Del/Prep/Spred

72, 76, 83/84

25 Calculate Avg Daily Balance 78

11 Close Balances to Next Year 64

01 Company Options Definitions 1/2

27 Copy a Control Group 86

02 Custom Report Definitions 41/42

20 Custom Report Line Detail 40

24 Custom Report Messages 69/70

21 Define Group of Reports 55/56

28 Distribution Profile, Branch

Allocation Table

87/88, 91/92
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General Ledger System - Application 1

14 Employee Report Security 81/82

23 Enter Client Number 66

19 Organizational Chart 36

12 Post From Other Applications 68

09 Print Custom Reports 24, 28, 32, 32-1, 32-2, 32-4

10 Print Custom Reports

Outofbal

24, 28, 32

08 Print Standard Reports 19/20, 32-5

64 Reserved

22 Statement Pre-requisites 59/60

18 Sub-Account Titles 17/18, 21/22, 25/26, 29/30, 33/34

04 Trans Dsply/Corr/Drop/Xfer 11/12

05 Trans F-M/Delete/Xfer/Clsd

Grp

12

17 Transaction Deletion 16

06 Transaction Entry 8

07 Transaction Entry Past/Future 8

GL GOLD

Bit
#

Function Name Function

01 Access

GOLD Services - Application 8

Bit
#

Function Name Function

21 ATM Comparative Totals OBSOLETE

12 Bank table Inquiry OBSOLETE

13 Bond Redemption OBSOLETE

20 Calculate Date or Days OBSOLETE

07 Check Recon Detail/Summary
OBSOLETE

09 Check Recon Mass Deletes
OBSOLETE
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GOLD Services - Application 8

08 Check Recon Print Reports OBSOLETE

11 Check Recon Transmission Hist
OBSOLETE

10 Check Recon Void Checks OBSOLETE

31 Comp Track Branch Setup 100, then 107/108

34 Comp Track Calculation (INQ) 100, then 113

33 Comp Track Default Setup 100, then 111/112

28 Comp Track Hist Summary (INQ) 100, then 101

29 Comp Track History Detail 100, then 103/104

30 Comp Track Pay Setup 100, then 105/106

32 Comp Track Teller Setup 100, then 109/110

22 Deposit Audit Confirmation OBSOLETE

19 Deposit Event Setup OBSOLETE

17 Field Level Security (Loans - APR
screen) OBSOLETE

01 G/L Autopost Setup   OBSOLETE

16 Holiday Scheduling (Loan Past Due
Notices) OBSOLETE

04 IRS Create Returns (F/M) OBSOLETE

05 IRS Delete All Returns (INQ)
OBSOLETE

02 IRS Information Returns OBSOLETE

03 IRS Print All Returns (INQ) OBSOLETE

18 Loan Additional Fields Services
OBSOLETE

23 Loan Audit Confirmation OBSOLETE

06 Online ACH Posting OBSOLETE

14 Online ATM Journal OBSOLETE

27 Privacy Options OBSOLETE

15 Store/Forward Display/Print
OBSOLETE

24 System Printing OBSOLETE

25 WWW ACH Batch Queue OBSOLETE

26 WWW ACH Security OBSOLETE
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GOLDPhone Processing - Application 35 - OBSOLETE

GOLD ExceptionManager

Bit # Function Name Function

15 Allow Change To Transaction

16 Allow Other User Pref Setup

10 Can Post Loan Items

4 Create Notification of Change

17 May Make Posting Decisions

11 Officer/employee Acct Access

2 Process Exception Items

13 Z Allow Save/remove Selections
OBSOLETE

8 Z Calibrate Printer OBSOLETE

6 Z Create a Chargeback Item
OBSOLETE

5 Z Create a Return Item (noinq)
OBSOLETE

7 Z Print Reports and Notices
OBSOLETE

9 Z Save Notice Headers OBSOLETE

12 Z User List Maintenance
OBSOLETE

GOLDTeller Security

Bit
#

Function Name Function

14 Allow Changing Institutions Change Institutions

04 Check Imaging

09 Clear/Synchronize Totals Clear PC Totals/Synchronize PC Totals With Host Totals

16 Database Backup/Restore Backup Data Files/Restore Data Files/Delete Data Files

05 Forms Design View/Modify Forms and Droplists

15 GOLDTeller Platform Platform Session

12 Jrnl Search on Other Opers Journal/Forward on Other Operators

03 Not Used

01 Operator File Operator Information



Setting Up Security54

© 2024 DHI Computing Service, Inc.Last updated: 9/9/2024

GOLDTeller Security

36 Platform Delete/Merge
Sessions

35 Platform File Directories

34 Platform Options

37 Platform Sales Tracking

33 Platform Setup

08 Print Configuration Form/Font Configuration

11 Signature Capture Signature Capture and Display

02 System Configuration System Configuration

10 System Fields Dictionary System Field Dictionary

06 Transaction Design Transaction Design/PC Institution Options

07 Transaction Selection Design Transaction Selection Design

13 Upload/Download Data File Upload File to Host/Download File to Host

GOLDTrak Loan Tracking System

Bit # Function Name Function

58 148 Access Apr Screens

36 Access F1833, Plaza Savings

29 Access To Appl. On Dead File

7 Access To Docprep (pf2) Screen

34 Access To F4385 - Allow Docs

1 Access To GOLDTrak System

37 Administrative Security

44 Agent Screen Access

18 Allow Unlk Of Lock, Table Flds

17 Allow Update of 'lock' Group

30 Allow Update to Default Number

2 Appl. Inquiry, F/m, or New

35 Appraisers I=select, F=change

22 Appraisers Table #3

46 Branch Manager Override

38 Branch No. Control On New Apps

39 Branch Supervisor Security
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GOLDTrak Loan Tracking System

45 Broker, input, no Status

23 Brokers Table #4

5 Build Document Formats (pf2)

6 Formula Setup (pf2)

43 Formula Test Mode Access

54 Freddie Mac Order Screen

56 Internet Queue Security

53 Inventory Queue Drop Security

19 Literal Cnst & Table Acc (pf2)

28 Literal Constants Access #0

21 Loan Officers Table #2

20 Loan Programs and Office Tab#1

41 Loan Que Printing

50 Lock Group 10 Access

51 Lock Group 11 Access

52 Lock Group 12 Access

47 Lock Group 7 Access

48 Lock Group 8 Access

49 Lock Group 9 Access

3 Modify Group Input Formats

10 Move Info To Servicing Files

33 New X-add Fm,limit Inq- Tables

24 Override All Lock Security

31 Override Off # Limits - Tables

32 Override Status Code - Tables

16 PC Forms Upload

11 Print Document Params. (pf2)

9 Print Documents

12 Print Field Names (pf2)

8 Print Formulas (pf2)

13 Print Input Groups (pf2)

15 Process Formula Calculations

55 Release Formulas New Fmlas
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GOLDTrak Loan Tracking System

4 Rename Field Names (pf2)

14 Report Writer Access From Here

42 Secondary Marketing

57 Unlock Application Security

27 Verification Of Deposits #8

25 Verification Of Employments #6

26 Verification Of Mortgages #7

40 Wire Screen Access

GOLD Miner Downloads

Bit # Function Name Function

64 Administrator User

01 CIF Download

06 Deposit Download

09 GOLDMiner Billing Download

04 GOLDPhone Download

07 GOLDTrak Deposit Download

03 GOLDTrak Download

05 Loan Download

08 Loan Payee Download

GOLDView

Bit # Function Name Function

02 Access to Deposit Reports

03 Access to General Ledger Rpts

06 Access to GOLDView Reports

01 Access to Loan Reports

05 Access to Payroll Reports

04 Access to Teller Reports

GOLDView 32

Bit
#

Function Name Function

02 Access to Deposit Reports
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GOLDView 32

03 Access to General Ledger Rpts

01 Access to Loan Reports

05 Access to Payroll Reports Payroll File Maintenance Report, FPSDR145

08 Access to Restricted Reports Employee Deposit Statements, FPSDR199 based on Warehouse
index category

07 Access to Special Reports Reports FPS GOLD processes, such as loan drops

04 Access to Teller Reports

06 Access to Warehouse Reports Reports processed by FPS GOLD requiring a separate ISO file

Loan System - OBSOLETE

Materials Management - OBSOLETE

Office Management - OBSOLETE

Old Office Management System - OBSOLETE

Organization Options - OBSOLETE

Payroll Management - Application 11

Bit
#

Function Name Function

43 Alternate Posting 1-15/2-15

41 Batch Reports

61 Change Client Number 66

13 Check Reconciliation 40

11 Co Emp Pay Change/F1 - Emp
Mstr

13<F1>/14<F1>, 38

21 Company Benefits 1-5/2-5

19 Company Deductions 1-3/2-3

18 Company Earnings 1-2/2-2

28 Company User Fields 1-12/2-12

33 Daily F/M 59.1.1

16 Dept Employee Changes 58

37 Distribution 59.1.6
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Payroll Management - Application 11

08 Emp. Benefits 33/34

04 Emp. Earnings/Deductions 21/22, 25/26

06 Emp. Evaluation

36 Emp. Not Posted and
Balancing

59.1.4, 59.1.13

03 Emp. Payroll History 17

05 Emp. Profile

15 Employee Master 13/14, 13<F1>/14<F1>, 13<F2>/14<F2>, 13<F7>/14<F7>,
13<F10>/14<F10>

34 Employee Master and Labels 59.1.2, 59.1.1

29 Employee Number Change 1-13/2-13

49 Employee Pay Amounts 13<F1>/14<F1>

35 Employee Pay Information 59.1.3, 59.1.5, 59.1.7, 59.1.9, 59.1.11, 59.1.14, 59.1.15, 59.1.18,
59.1.20, 59.1.21, 59.1.22

50 Employee User Field 1 41/42

51 Employee User Field 2 41/42

52 Employee User Field 3 41/42

53 Employee User Field 4 41/42

54 Employee User Field 5 41/42

42 FTE Report 59.1.19

23 Job Cost Codes 1-7/2-7

25 Job Description File 1-9/2-9

27 Job Status File 1-11/2-11

44 Monthly Tax Liability

26 Pay Grade File 1-10/2-10

10 Payroll Adjustments 12

17 Payroll Cycles 1-1/2-1

09 Payroll Posting - F/M 8, 15/16

38 Position Control and Budget 59.1.8, 59.1.38

30 Position Control Budget Info 1-14/2-14, 2-8<F1>

24 Position Control File 1-8/2-8

55 Post Rate Changes 20, 24

40 Posting Errors 59.1.12

12 Print Payroll Checks 36
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Payroll Management - Application 11

02 Print Reports 59-1.34-42 / 59.2.34-42

22 Project Codes 1-6/2-6

01 Report Formats 59.2.34-42

07 Report Writer 63.1-63.7

63 Report Writer Report Setup 63.2-63.4

64 Report Writer Run Report 63.1, 63.7

20 Tax Tables 1-4/2-4

39 Time Cards 59.1.16

14 Void Checks 44, 48

PC Check Image Utilities

Bit
#

Function Name Function

06 Modify Auto Print Options

03 Process Check Exceptions

02 View Check Exceptions

01 View Check History

05 View Check Image Options

04 View Check Images

Prrpts0 -  OBSOLETE

Report Warehouse Menu - Application 53

Bit
#

Function Name Functions

03 Print Position Selection 37/38

02 Report/Line/Index Selection 31/32, 33/34, 35/36

01 Warehouse Directory 1/2

04 Warehouse Options 39/40

Report Writer - OBSOLETE

Reports and Dacosys Options

Bit
#

Function Name Function
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Reports and Dacosys Options

02 Report Functions

01 Update Functions

Security Management - Application 19

Bit
#

Function Name Function

01 Administrative Functions

04 Appl. Programmer Functions

03 Print Requests (2, 3, 4) <F9>, then 2, 3, or 4

05 Reset Security Code <F11> Reset Emp. Password

02 Reset Security Violation (F9) <F9>

System Print Program

Bit
#

Function Name Function

01 Access

Utility Programs - Application 10 - OBSOLETE

Web Security 

Bit
#

Function Name Function

16 Allow Customer Blog Web banking

02 Allow Software Downloads Web banking

13 Allow Ticket Submission Web banking

01 Allow Web Logon/training Web banking

14 Allow Wo Prioritization Web banking

06 EIS All Web banking

12 EIS Branch Web banking

07 EIS Division a Web banking

08 EIS Division B Web banking

09 EIS Division C Web banking

10 EIS Region Web banking

11 EIS State Web banking

05 E-work Orders Web banking
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Web Security 

15 Executive Files Web banking

04 Executive Information System Web banking

03 Knowledge Base Access Web banking
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Field Level tab

The Field Level tab on the Security > Setup screen is used to set up restricted file maintenance to specific data
fields for employees. In order to use this feature, employees must first be set up with CIM GOLD application and
screen security using the CIM GOLD tab before any field-level security can be tied to them. If an employee is
tied to a CIM GOLD profile, the profile name is used to set up restricted access in Field Level Security. If
multiple profiles with different field-level security are tied to an employee, all the secured fields from all profiles
will be restricted for the employee.

If the Field Level Security feature is not going to be used by your institution, no work is required with this screen.
When “Maintain” access is given to applications and screens, all the fields are file maintainable until they have
been restricted individually or on a profile setup using this screen.

NOTE

Field Level Security is for CIM GOLD applications and does not
correspond with any other PC product.

The Field Level Security screen is organized into two sections. The Restricted Fields list view shows all the
fields that are restricted for the employee or profile selected. The All Fields list view is used to restrict the
specific fields for an employee or profile based on Record Type. 

The Record Type dictates what fields are available for the specified type. For example, CSPI is for CIS
Customer Profile. The records are the same as the records used in GOLDWriter and system history. For a list
of record types and descriptions, see the Master Records section in the help file.

If your institution uses field-level security for employees and CIM GOLD profiles, use the following instructions
for setup and changes. 

For details on how to use any of the fields on this tab, click in the field and press <F1>.
 
Setting Up Field-level Security

To set up or change field-level security for employees and profiles, complete the following
steps. 

1. Select Employees or CIM GOLD Profiles on the left side of the screen.

2. Select the appropriate employee or profile from the list.

3. Click on the Field Level tab.

4. Select the Record Type from the drop-down list; all fields in the selected record will be shown.

5. Click on the Restrict box next to the field to restrict access and add it to the list of Restricted Fields.

6. Click <Save Changes> after restrictions are made for each Record Type. 

If any fields need to be unrestricted, select them on the Restricted Fields list (use the <Ctrl> button on your
keyboard to select multiple fields). Then click <Clear Selected Restrictions> and <Save Changes>.
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Enhanced Interface
The Enhanced Interface is an option you can select in CIM GOLD that changes the look of CIM GOLD, allowing
you to easily recognize and use account information on often-used screens. Each Enhanced Interface can be

customized for each user. The Enhanced Interface uses Windows®-type tiles, top menus, color-coded
navigation tree, customizable logos, and more. Screens look and function the same as they always have; the
Enhanced Interface just helps you find information faster, is easier to navigate, and allows for more user-specific
preferences.

The following are examples of CIM GOLD in regular mode and Enhanced Interface mode.

Regular mode:

Enhanced Interface mode:
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For more information about this unique feature, see the following sections.

Getting Started

Options

Adding your business logo to the Home screen

Enhanced Tree

Home Screen

Live Tiles
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Getting Started
Options

Before you can begin using the CIM GOLD Enhanced Interface, you must set up some options on the Options >
User Preferences, Enhanced Interface tab. Start by checking the Use Enhanced Interface checkbox. For more
information about each of the options on this tab and how they affect CIM GOLD, see the Enhanced Interface
Tab documentation.

Adding Your Business Logo to the Home Screen

You can add your business logo to be displayed on the Home screen when in Enhanced Interface mode. Before
you can add your business logo, save the logo on the network or on your computer where you can easily find it.
The logo can be any size, as the Alignment option can help you decide how to display the logo (as described
in step 4 below).

To add your logo:

1. Select Options > User Preferences from the top menu bar, then click on the Enhanced Interface tab.
2. In the Background Image field group on that tab, click <Choose File>, select the logo, and click <Open>.

 If you want to select a series of images, first make sure you've saved all the images in the same folder on the

network or your computer, then click <Choose Folder>. Locate the saved folder, select it, and click <OK>.

3. Set how transparent you want the logo to be displayed by choosing a percentage in the Opacity field. 100%
means the logo (images) will be displayed clear and unfiltered. 1% means the logo will likely not show up at
all, or very lightly. The default is 30%, as shown in the example below.

4. Use the Alignment field to select how CIM GOLD will display the logo (or images). Possible choices
include:
· Center the image in the background without modifying the size
· Fill the entire background with the image, distorting the image if necessary
· Fill as much of the background as possible with the entire image while retaining the aspect ratio (default)
· Fill the entire background while retaining the aspect ratio, cropping the image if necessary

5. If you are using a folder of images rather than just one image (as explained in step 2 above), select when the
system rotates the image to display a new one from the folder.

6. Click <OK> to save your changes.

The following is an example of how the FPS GOLD logo looks on the CIM GOLD Home screen with 30%
opacity:
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Enhanced Tree
Enhancements have also been made to the CIM GOLD left navigation tree. 

Show or Hide the Navigation Tree

· Show the tree by clicking anywhere in the Navigation bar on the left of the screen. 
· Hide the tree by clicking the Navigation bar again. 

Expand or Collapse the Headings

Two buttons at the top of the tree, <Expand All> and <Collapse All>, allow you to expand the tree to show all
available screens or collapse the tree to show only the main headings in the tree. 

Search for a Screen By Name
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A search box at the top of the tree dynamically expands and collapses the tree as you type to show only
screens with matching text in the title of the screen. This is particularly useful for screens that you use only
occasionally and don’t know the path to the screen. See the following example. If a screen is under a heading,
the list will be expanded to show where it is in that heading (for example, Loans > Collections > Account
Delinquency in the example below).

Hide a Heading

If there is a heading in the tree that you do not want to see in the menu or in the tree, you can hide the heading
by right-clicking on it and selecting “Hide in Tree” and/or “Hide In Menu,” as shown below.
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Hidden items can be shown temporarily by checking the Show Hidden Items in Tree box at the top of the
tree. Hidden items will also show up if a matching screen is found while doing a screen search. Major headings
can also be permanently unhidden again by right-clicking on the major heading and unchecking the appropriate
hide option (after checking Show Hidden Items in Tree).
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Home Screen
The enhanced CIM GOLD Navigation Home screen has been patterned after the Windows 8 tile concept. 

Adding Tiles

From the enhanced navigation tree or from the enhanced navigation menu, you can pin any CIM GOLD screen to
the Home screen by right-clicking on the item and selecting “Pin to Home Screen.”

This will add a tile for this screen to the home page, as shown below.

Changing Color, Size, and Position

Once you have selected all the screens you want to display on your Home screen, you can customize the
Home screen.

To add colors to tiles to visually separate them on the Home screen:

1. Right-click on the colored strip to the left of a heading, as shown below.
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2. Click on a color in the palette to change all tiles in that heading to that color. See the following examples.
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The tiles can then be rearranged, grouped, and resized by clicking on the white dots in the lower-right corner of
any tile. This opens a graphical menu of options to enlarge, shrink, move, or un-pin the tile. 

Click on the "Arrange" icon  or click and hold a tile for a quarter of a second to put the Home screen into
maintenance mode. Then you can move and group all the tiles. 

Using More Than One Home Page
You can create as many as three home pages. Select the home page you want to open by clicking the arrow

next to the Home icon at the top of the screen .  See the example below.
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When you open a home page, the page title will display at the top of the screen and then fade out after three
seconds.
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When you open a home page, its title (outlined in red here) displays briefly.

You can move between the home pages three ways, using the steps below.

To move between home pages:

Using the mouse:
1. Position your mouse cursor over an empty space inside the home screen. 
2. Press and hold the left mouse button.  
3. Move the mouse cursor on the screen vertically to change pages--down to go to the next page and up to go

to the previous page. 

Using the menu:
1. Click the drop-down arrow next to the Home icon at the top of the screen.  
2. Select a page you want to open.

Using the keyboard:
1. Press <Ctrl>+<F12> to go to the next home page.  

Home Page Titles
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You can create titles for the home pages in the User Preferences dialog box, Enhanced Preferences tab (CIM

GOLD Options Menu > User Preferences). See the example below.

CIM GOLD Options menu, User Preferences

To move a tile from one page to another:

1. Click on the three dots at the bottom right of the tile, then click on the Arrange icon . At the bottom of
the tile, there will be three buttons with the numbers 1, 2, and 3.  

2. Click on a button to send the tile to that screen. Hovering your mouse pointer over the button will open a
tooltip that will tell you which home screen it will be moved to. See the example below.



Enhanced Interface 77

© 2024 DHI Computing Service, Inc. Last updated: 9/9/2024

Live Tiles
Live tiles make it easy to open a CIM GOLD screen with pre-populated information or to perform screen
functions without leaving the Home screen. 

For example, the Customer Search live tile contains a text box where you can enter the data you would like to
search for. As data is entered in the box, the live tile detects the type of data being input and automatically
selects the entity to search for. You can also enter the data and select an entity from the drop-down list by
clicking the drop-down arrow. See the examples below.

When you type in the first few letters of a name, CIM

GOLD detects that you are searching for a name.

         

When you enter the first few account numbers, CIM

GOLD detects that you are searching for an account.

        

Click the drop-down arrow if you want to select the

entity type from the list.

Press <Enter> on your keyboard to open the CIS Customer Search screen and perform the search. See the
following example.
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CIM GOLD Features
In CIM GOLD, use the left navigation tree to open screens (depending on if you have security for that screen). If
you are using CIM GOLD's Enhanced Interface, you can also open screens from the top menu or from
customized tiles on the home screen.

The left navigation tree looks somewhat different when using the Enhanced Interface. The example on the left
below shows the navigation tree as it looks when the Enhanced Interface is not being used. The example on the
right below shows the navigation tree when the Enhanced Interface is being used. 
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Navigation tree w ithout Enhanced Interface                   

Navigation tree w ith Enhanced Interface.
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Screen Search

At the top of the left navigation tree is a screen search feature. Enter all or part of a screen name in this field,
and the system will find that screen in the tree view. This feature makes it easy for you to find exactly the
screen you want to open.

For example, if you wanted to find the Account Delinquency screen in the Loan system, you could enter
"delinq" in this field, and all screen names with "delinq" will be displayed in the navigation tree. 

· Clicking the x icon  removes the data entered in the search and returns the navigation tree to its original
view. 

· Clicking the Collapse all link collapses the navigation tree menu, so that only the main headings are
displayed.

· Clicking the Expand all link expands all headings so that each of the screens within that heading are
displayed in the navigation tree menu.

Note: This navigation tree looks different if using CIM GOLD's Enhanced Interface. 

See the following examples:
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Search results, normal interface

            

Search results when using the Enhanced Interface

Finding Accounts

The first screen you see after you log on to CIM GOLD is the Customer Search Screen. Use this screen to find
the person or account you want to view. For more information about the details of this screen, see the Customer
Search Screen topic. 

The following is an example of this screen:
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Moving Between Screens

Once you have found and selected an account, you will notice some buttons and fields at the top of the screen,
as shown below. Use these features to open account quickly. 

1. Click the Back arrow  to open the last screen you were on. TIP: <Alt> + left arrow on your keyboard also
takes you to the last screen. 

Click the Forward arrow  to open the next screen you were on. TIP: <Alt> + right arrow on your keyboard
also takes you to the next screen. 

2. Click the pop-out icon to "pop out" the current screen into its own window so you can keep it open while
navigating around CIM GOLD to do other tasks.    

3. Use the black arrow keys to quickly open the next or last account number on file.  

a. Click the First button  to go to the very first account on file in numerical order.

b. Click the Previous button  to bring up the previous account number. 

c. Click the Next button  to bring up the next account number (in numerical order). 

d. Click the Last button  to go to the very last account number on file in numerical order.
4. If you already know the account number you want to open, enter that number in the Fast Goto Account field,

and then click the green Go arrow . The system will display that account's information for the screen
you are on. 
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5. Click the Customer Bubble icon  to open an "at-a-glance" view of your customer's relationship to the
bank, including how many accounts and what types of accounts the customer has at your bank. This bubble
is customizable to your needs. See the Customer Index Bubble section in the CIS User's Guide in
DocsOnWeb for more information.

Additional CIM GOLD Information

For more information about each of the menus in CIM GOLD, see the Main Menus.

 

https://secure.fps-gold.com/docsOnWeb/uguides/CIS/ucs2s2.htm
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Main Menus
The menus at the top of CIM GOLD can change depending on which screen you open. However, there are seven
main menus, as described below.

File Menu

The following table describes each of the menu items under the File heading in CIM GOLD.

Menu Item Description

Go To
Screen...

This function opens the Enter Screen ID dialog box. Here you can enter a number in
the Screen ID field and click <OK> to display that screen. The screen identification
number is located in the bottom-right of the screen in the status bar (see the Status
Bar section below).

Initiate CIM
Repair

Click this menu item to quickly repair problems you may encounter while running CIM
GOLD. The following dialog box displays:

When you click <OK>, the following dialog box displays:

When you click <Yes>, CIM GOLD closes and restarts automatically. When CIM
GOLD restarts, the problem you encountered should be fixed. 
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Menu Item Description

Platform Click this menu item to open another menu that you can use to start, stop, or
terminate Platform.

GOLDTeller Click this menu item to open another menu with the following options:
· Close GOLDTeller
· Reconnect Remote Override/Chat
· Change File Directories
· Terminate GOLDTeller

Get Host Statistics This function opens the Host Statistics dialog box, shown below.

The Host Statistics dialog box displays general information about the PC using the
CIM GOLD program. It also displays various response time fields, including fastest,
slowest, difference, and average. Click the <Refresh> button to reload the dialog box
and display current data for that terminal.

Change Working
Set

Use this function to toggle between different modes of CIM GOLD: Production, Month
End, and Testing. Production is the live file, and changing fields in this mode will
change account records for actual customers. Month End mode displays live files as
of the last day of the previous month. Testing mode is a test file for your institution;
changes are saved in test files and not on live accounts.

Change Client
Number

Click this menu item to open another menu with the following options:
· General Ledger
· Accounts Payable
· Fixed Assets
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Menu Item Description

· Payroll

Select one of the options to open a dialog box where you can change the client
number for that option.
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Error Provider
The error provider is a red circle that is displayed on the screen next to a field that contains incorrect data or
incomplete data. Often within CIM GOLD, changes to one field will affect another field. If a change requires entry
or a fix in another field, this red circle will display.

Move your mouse cursor to hover over this red circle. A message will display stating the problem. Once the
problem is fixed and you tab out of that field, the red circle will disappear. See the following example.

Note: If you try to save a screen with an error provider, a message will display that states, "You must fix all
errors before saving." When you click <OK> to that message, you will be returned to the screen to fix your
errors. If there are multiple tabs within your screen, the error may be on any of the tab pages. Check all tabs if
the message indicates an error and you do not see the error provider. When an error provider exists on any of
the tabs on a screen, it may sometimes cause the <Save Changes> button to be disabled. In other words, if an
error provider exists, you may not be able to save changes made to the screen until the information in the  field
with the error provider is corrected.



CIM GOLD Features 89

© 2024 DHI Computing Service, Inc. Last updated: 9/9/2024

Warning Provider
The warning provider is similar to the error provider. It is a yellow triangle that appears next to a field to display a
warning. Move your mouse cursor to hover over the yellow icon and the warning message will display. The
difference between the error provider and the warning provider is that the <Save Changes> button will be enabled
and the screen will allow you to click <Save> when warning providers are on the screen.
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Information Provider
The information provider is similar to the warning provider. It is a white circle that appears next to a field to
provide more information for that field. Move your mouse cursor over the white icon, and the message will
display. The <Save Changes> button will be enabled even if there are information providers on the screen.
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Account Status Bar
The red Account Status Bar at the top of some screens displays information such as "No account selected" if
you try to enter an account-based screen with no name or account selected. (See the example below.) Another
example of information that displays in the red Account Status Bar is that a certain feature or function is needed
on an account in order to use that screen.
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User Preferences
Select "User Preferences" from the Options menu to open preferences for your CIM GOLD setup. 

IMPORTANT

You must have appropriate security in order to change User
Preferences. Your institution's system administrator can grant this
security by selecting "Maintain" for the first item, [Customer Search
Screen], on the Security > Setup screen, CIM GOLD tab. See the
example below.

Security > Setup Screen, CIM GOLD Tab

See the following topics for more information about each of the tabs on the User Preferences screen:

· General tab
· Enhanced Interface tab
· Scanners tab

General Tab

The following is an example of the Options > User Preferences screen, General tab, followed by descriptions of
each of the options.
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Options, User Preferences Screen, Options Tab

Option Description

Show Post Logon
Processing Information
Status

Checkmark this field if you want CIM GOLD to display the status dialog box
where available when the system is processing information on the logon.

Show Loading Screen
Information Status

Checkmark this field if you want CIM GOLD to display the status dialog box
where available when the system is loading screens. For example, CIM GOLD
displays this dialog box when loading the Customer Relationship Management >
Customer Profile > Platform tab and the CIS > Comments screen.

Use List of Comment
Shortcuts

Checkmark this field if you want to use the Comment Shortcut list when creating
comments on the CIS > Comments screen. To add items to the Comment
Shortcut list, select "Comment Shortcut Setup" from the Options menu.

Skip Showing Splash
Screen on Open

Checkmark this field to block the CIM GOLD splash screen from being shown
when logging on.

Skip Restoring
Expanded Navigation
Tree

Checkmark this field to cause the navigation tree on the left side of the CIM
GOLD screen to only display primary headings, such as CIS, GOLD Services,
Deposits, Loans, etc. To see sub-headings, you must double-click a primary
heading to expand the tree view.

Note: If you check this field, the Skip Expanding Navigation Tree (1st Level)
field becomes enabled. The Skip Restoring Expanded Navigation Tree field
affects the Skip Expanding Navigation Tree field.
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Option Description

Skip Expanding
Navigation Tree (1st
Level)

Checkmark this box if you want CIM GOLD to not expand the first-level headings
in the Navigation tree automatically upon logging on.

Note: This field is not enabled unless the Skip Restoring Expanded
Navigation Tree field (see above) is checked. The Skip Restoring Expanded
Navigation Tree field affects the Skip Expanding Navigation Tree field.

Show Help Paths on
Help Function Calls

Checkmark this box to cause a Help Tracing dialog box to appear when you
select "Mini-Application help" from the Help menu. This option is primarily for
FPS GOLD use. When this box is checked, the Help Trace dialog box will
display the path and name for the help file, as well as the help keyword, if
available. This keyword can be used in the Master help search as an index
search.

Enable ToolTip Pop-up
Help

Checkmark this field to enable ToolTip Pop-up help throughout CIM GOLD. This
kind of help is displayed when you hover your mouse over fields to show
mnemonics or brief descriptions of what to enter in the field, among other things.
See the following example of a ToolTip Pop-up.

Use Branch Zero
Instead of Default on
Queues

Checkmark this field to cause the system to display queues for branch number
zero when opening the Collection Queues or Contact Queues screens in the
Queues system. If this checkbox is left blank, the screens will open displaying
queues for the branch number the PC is set to.

Use White Background Checkmark this box if you want CIM GOLD to have a white background instead
of gray.

Max Nbr to Display in
Customer Search

Use this field to select the default for the maximum number of entities you want
displayed for a customer search on the Entity Maintenance screen. For
example, if looking up “SMITH,” your institution may have more than 1,000
customers with that name. The number you enter in this field limits the screen to
display entities for only that number of Smiths. 

On the Entity Maintenance screen, you can click the more button  to display
more names than listed.

Harland Active View
URL

Use this field to enter the Harland website address if your company has an
agreement with them. Harland is a third-party system used for check image
retrieval.

Customer Profitability
Statement Logo URL

Use this field to select the logo to print on the Customer Profitability Statement. 

Automatically Show
Customer Information

Checkmark this box if you want CIM GOLD to automatically display the
Customer Index Bubble when opening screens in CIM GOLD.

https://secure.fps-gold.com/docsOnWeb/uguides/CIS/ucs2s2.htm
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Option Description

Popup

Move GOLDTeller
Customer Information
Popup to Left

Checking this box moves the Customer Index Bubble to the left of the screen
when in CIM GOLDTeller.

Auto-hide Navigation
Tree

Checkmark this box to hide the navigation tree when your cursor moves focus
from the tree to a screen in CIM GOLD. This makes more room on your monitor
to view the screen. When this field is checked, the navigation tree containing all
screens available to you will hide when the mouse cursor is moved to a screen
on the right. To view your navigation tree again, simply move your cursor to the
left of the screen in CIM GOLD, and the navigation tree will display. If this field is
unchecked, the navigation tree will always be displayed on the left unless you
manually close it.

Disable Chat Checkmark this box if you want to turn off your chat capabilities. You can use
chat to communicate with other employees in your bank through CIM GOLD. If
this field is checked, your name will not show in the Chat list.

Chat Notification
Sound

Use this feature to select a sound when there is a chat communication sent to
you. 

· You can select a Beep or Ring to alert you.
· Select "None" for no notification.
· Select "Instant," and the Chat prompt will be immediately shown in the

current window.

Disable Remote
Override

Checkmark this box if you want to disable the ability to override teller
transactions remotely. You must be logged in to CIM GOLD to get the override
transactions.

Use Sound Notification Check this box if you want a sound notification for use with remote overrides.

Set Focus to Account
Fields On New Screen

Checking this box places the cursor in the first account number field on the
screen when opening a new screen. If it is not checked, the cursor will be placed
on the first field on the screen according to tab order.

Start Platform After
GOLDTeller Logon

Checking this box causes Platform to launch automatically upon logging in to
CIM GOLDTeller. This means you don't have to launch it separately.

Enhanced Interface Tab
Use the options on the Enhanced Interface tab of the User Preferences screen to use CIM GOLD's Enhanced
Interface and to set up the way the Enhanced Interface will look. The following is an example of the Enhanced
Interface tab, followed by descriptions of each of the options.

https://secure.fps-gold.com/docsOnWeb/uguides/CIS/ucs2s2.htm
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Options > User Preference Screen, Enhanced Interface Tab

No. Option Description

A Use Enhanced
Interface

Check this box and click <OK> to enable CIM GOLD's Enhanced Interface. CIM
GOLD will immediately operate in enhanced-interface mode. If you uncheck this
box to stop using CIM GOLD in enhanced-interface mode, you must restart CIM
GOLD to go back to the regular interface.

B <Import
Settings>

Click this button to import settings for the Enhanced Interface that you previously
saved by exporting the settings, as described below. Once you import the
settings (an .xml file), all options from that import file will be applied. This is
useful if you are setting up many CIM GOLD users and want to use the same
setup for each. This allows you to quickly import the settings and apply them for
each user.

C <Export
Settings>

Check this box to save the Enhanced Interface settings to a file. The following
options on this tab are saved to the file: 

· Options A, D, E, F, G, H, I, J, K, N, O, and P from above. (Only the path
listed in K is saved to the file, not the image itself.)

· Information about tiles currently pinned to the Home screen.
· The colors defined in the navigation tree.
· The hidden state of items in the navigation tree.
· The hidden state of items in the top menu.

D,
E

Navigation Tree This is the font size of the text in the navigation tree. If you check the Display on
Startup box, the navigation tree will be visible as soon as CIM GOLD is opened.
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No. Option Description

F,
G

Navigation Menu This is the font size of the text in the top menu. If you check the Hide
Navigation Menu box, the top menu is hidden. The top menu has all the
screens that the navigation tree on the left has; however, if you prefer to select
screens from a menu, this option is available to you.

Note: Showing the top menu takes up more vertical screen space and could
cause screen content to be pushed off the bottom of the screen on some monitor
resolutions.

Tile Properties
field group

Use the fields in this box to establish how you want the tiles to be displayed on
the Home screen.

H Row Count This is the row count that the Home screen uses. The vertical space available to
the Home screen is divided by this number to get the row size. This row size is
used in determining the size of tiles and their header font sizes. It is also used to
create the virtual grid used when laying out tiles. The virtual grid will use this
value for the cell width and height.

I Base Tile Cell
Span

This is the number of rows and columns in the virtual grid that the smallest cell
will span. The medium cell will span twice this number for its width, and the large
tile will span twice this number for both its width and height. 

J Font Percentage This is the percentage of a virtual grid cell height that will be used to determine
the height of the font for the tile header.

H, I, and J Example: If the user is running CIM GOLD at full screen at
1024x768, the entire CIM GOLD window would be 1024x768. The area given to
the Home screen would be smaller than that (such as 1150x600). Dividing the
height of 600 by 48 (option H above) we would determine that each row is 12
pixels high. Multiplying the 12 pixels by 8 (option I above) we would determine
that each small tile is 96 pixels high. We use the same value for the width so the
small tile is 96x96, the medium tile is 192x96, and the large tile is 192x192. We
then multiply 12 (our row height) by 1.20 (option J above) to get a font height of
14 pixels.

Background
Image field
group

Use the fields in this box to establish a logo or group of images to be displayed
on the Home screen. See Adding your business logo to the Home screen for
more information.

K Path This is the path to an image or folder that contains images you want to use as a
background to the Home screen. If it is the path to an image, that image will
always be shown. If it is the path to a folder, CIM GOLD will randomly cycle
through any images in the folder. (Images of type .jpg, .png, .bmp, and .gif are
supported.)

L <Choose File> Click this button to open a file dialog box where a file can be selected for option
K (see above).

M <Choose Folder> Click this button to open a directory dialog box where a folder can be selected for
option K (see above).
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No. Option Description

N Opacity This is the opacity of an image. If the value is 100%, the image will be displayed
on the Home screen as-is. The closer this value is to 0, the more transparent the
image will become. At 0, it will be invisible.

O Alignment Use the Alignment field to select how CIM GOLD will display the logo (or
images). Possible choices include:

· Center the image in the background without modifying the size
· Fill the entire background with the image, distorting the image if necessary
· Fill as much of the background as possible with the entire image while

retaining the aspect ratio (default)
· Fill the entire background while retaining the aspect ratio, cropping the

image if necessary

P Cycle Interval If you are using a folder of images rather than just one image (as explained in
option K above), select when the system rotates the image to display a new one
from the folder.

Scanners Tab
Scanner functionality is available in CIM GOLD. You can use bar code and magnetic strip scanners to quickly
locate bank customer data that includes some form of identification document with scanning data available. The
scanners we have currently programmed include the following:

· Honeywell Xenon 1900 series (bar code)
· Magtek SureSwipe HID series (magnetic strip) 

If you would like to implement this feature for your institution, send a work order to request it. Institution option
OP21 -SCAN (Enable Scanners in CIM GOLD) must be turned on. A $300.00 one-time activation fee will be
assessed.

The CIS Customer Search, Entity Maintenance, CIM GOLDTeller, and GOLDTeller Platform screens will
recognize these scanners. They automatically perform a customer search based on the document you scan.
Once scanning is complete, you can choose the entity you want to open just as you currently do on these
screens. Other screens can be programmed as requested.

Both of these scanners are Windows Human Interface Devices (HID). They work with CIM GOLD screens
without requiring extra buttons or clicks on the screen to activate them. 

If your institution uses a terminal server or Citrix environment, you will need to set the appropriate serial port and
download the associated bar codes based on the configuration of your scanner.

Other devices might work with this feature, but FPS GOLD will have to do some programming to get them in the
scanner device list. Contact your FPS GOLD account representative if you would like additional scanning
capabilities.

IMPORTANT

http://www.fps-gold.com/about/contact_fps.asp
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The scanners will only work if you are running Microsoft

Windows® 7 or later. They will not work with Windows® XP.
Please contact your client services representative with any
questions about device support before purchasing any devices.
FPS GOLD will not purchase any other devices for this feature.

You must check the Use? checkbox on the Options menu > User Preferences screen, Scanners tab, for each
scanner that is connected to your computer. See the following example.
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Right-click Menu
Many fields and list views in CIM GOLD have right-click menus like the example shown below. To open a right-
click menu, place your cursor in the field or list view and right-click. Functions in this pop-up menu change
according to where your cursor is on the screen at the time you right clicked.

For example, right-clicking on any list view in CIM GOLD brings up the following pop-up menu:

The following table explains the functions available when you right-click on a list view.

Edit menu Using the edit menu, you can copy cell data (or select all cell data to be copied). Once

you copy the list view data, you can paste it into another program such as Microsoft®

Excel. The data will stay in the table format of the list view.

Any items on this menu that are grayed out do not function, including Edit Cell Value,
Clear Cell Value, Cut, Paste, Undo, and Redo. These items are disabled because you
usually change information in list views using the fields below the list view.

Printing menu The Printing menu is used to print information listed in a list view. Using this menu, you
can
· print the information in the list view; 
· set up the printer where you want to print the list view information; 
· print a preview of the list view to your computer screen before actually printing it to

paper; and 
· set up the page to print in portrait or landscape, increase or decrease margins, and

choose the size and source of the paper.

Export menu You can export the list view information directly to another file or program using the
Export right-click menu. 
· Export to Report Manager: Select this function if you want to export the data in

the list view to FPS GOLD's Report Manager program. 
· Export Selection to Tab Delimited Text File: If you select this function, the Save

As dialog box displays, asking you where you want to save the selection as a tab-
delimited text file. You can then open it in any tab-delimited file program or even
Microsoft Word, Wordpad, or Notepad. Use this when you only want a selection of
information instead of all the information in the list view. 

Auto Resize
menu

Use the Auto Resize menu to increase the columns on the list view table to display all
the data. 
· Auto Resize Grid: This will resize the entire list view, both columns and rows, to fit

the data. For example, if a column is decreased in size to make room so the data
appears cut off, select this option and the data will all display. 

· Auto Resize Columns: This option works similarly to the Auto Resize Grid. The
columns will increase to display all the data. 

https://secure.fps-gold.com/docsOnWeb/uguides/ReportManager/orm.htm
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· Auto Resize Rows: Select this option if you want rows to show all data and not
have collapsed data that is hidden. 

Find menu This is a useful function when you need to find specific information in a list view
containing lots of information.
1. Select this option. A Find dialog box displays. 
2. Enter information you want to find in the list view.
3. Click <Find>. The system finds all matches for your search and displays it in a

table. 
4. Double-click the item in the table to return to the list view with search results

selected.
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User-Defined Help
User-defined help can be created by employees at your institution for each screen in CIM GOLD. User-defined
help is information you write that will be useful for your employees. You must have proper security in order to
create user-defined help (see the Setting Up CIM GOLD section). Any employee with the security to use the
screen will be able to view the user-defined help.

To set up user-defined help:

1. Open the screen you want to add user-defined help for.
2. Select "User Defined Help" from the Help menu. The following screen will open:

3. In the screen provided, type any help you would like to tie to this screen.
4. You can change the font of the help by clicking <Font>, then selecting the size, font type, and font style you

want the help saved in.
5. Click <OK> to save the help for that screen. You can also print the help by clicking <Print>.
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How to ...
The following topics explain how to set up and use some basic functions in CIM GOLD.

How to...
search for accounts.
set up Speed Keys.
set up CIM GOLD screens.
set up Comment types.
set up Queues.
search for help on CIM GOLD.
print from CIM GOLD.
set up user-defined help.
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Search for Customers and Their Accounts
You can easily find customers and all the accounts linked to them. The system defaults to search by name, but
you can easily change the Search field to search by account, bank card, customer number, UCC number, etc.
Below the Search field is a drop-down list you can use to select different entities to search by.

1. Open the CIS > Customer Search or Entity Maintenance screen. 
2. Type the customer's last name in the Search field. 

If you press <Enter> on your keyboard, you will likely be able to find the customer's information you want. To
narrow the search further, enter a space and the first letter of the first name.

3. Once you find the customer you're looking for, click on the customer's name, and the accounts, boxes,
plans, and so on tied to that name will display in the bottom half of the screen. When you double-click on
account information, the screen tied to that account will display. For more information about which screen is
tied to the account when you double-click on it, see Set Up Speed Keys.  

For more information on performing searches, see the Customer Search Screen topic.

Tips for Searches

· If you are unsure of the spelling of a name, type the first few letters of the last name in the Name field.  For
example, if you know your customer’s last name is San-something, type San, then click <Submit>.

· If a name search retrieves too much information, consider the following: Names will display on the Search
Results screen, where you can find the name you are looking for and click on it to view that account owner's
information in the bottom half of the screen (see the following example). To limit the name search further, type
the last name, a space, and the first and middle initials in the Name field. For example, to look up John David
Smith, type “Smith JD.”

· The asterisk (*) is a wild card search that works on location, mailing labels, names, stock certificates, and
UCC entities. It searches the entire database and can take a few minutes. A warning message may be shown
asking you if you want to continue with your search. If you do, click <Yes>. All entities except locations and
mailing labels search only based on the beginning of the data. You can search locations for data in the first or
second address line, and you can search for any data on a mailing label.
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Set Up Speed Keys
In order to open screens more quickly, you can set up eight speed keys in CIM GOLD. The speed keys
correlate with the F2 - F9 keys on your keyboard and by double-clicking on your mouse. The following steps
explain how to set up speed keys.

Note: Each PC user using CIM GOLD will need to set up their own PC with speed keys.

1. Select “Speed Key Setup” from the Options menu. The Speed Key Setup screen will display.
2. Under each of the headings (such as Contact Queues, Customer Relationship Management, Deposits,

Loans, and Miscellaneous) is a list of screens. Click on the screen you want to assign a speed key to, then
drag and drop it over to one of the colored F2 - F9 key fields listed on the right. See the following example.

Drag a screen name to assign it to a speed key.

3. If you want to delete (clear) a screen from a speed key, click <C> next to the F2 - F9 key you want cleared.
To clear all speed keys (including the double-click speed keys), click <Clear All Fields> at the bottom of the
screen.

4. To set up the "Customer Search Fast Goto" options, drag and drop a screen into the fields in the Customer
Search Fast Goto (Double Click) Setups box. The fields in this box correlate with the Customer Search
screen. When you search for a customer and have a list of all the customer’s accounts, you can designate
which screen you want to go to once you double-click on an account. For more information about the
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Customer Search function, see Search for Customers and Their Accounts. You can set up a screen for both
loan and deposit accounts if you have security to it.

5. To set up the initial screen when you log on to CIM GOLD (the default is the Search screen), select the
screen and drag it into the Startup Screen field.

6. If you want to delete (clear) a screen from the double-click function, click <C> next to the Fast Goto screen
you want cleared. To clear all speed keys (including the F keys), click the <Clear All Fields> button at the
bottom of the screen.

7. Click <OK> when you are finished setting up speed keys and Fast Goto screens.
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Set Up CIM GOLD Screens
CIM GOLD can be set up to use only screens pertinent to your institution. Complete the following steps to set
up screens your institution wants to use for CIM GOLD. Note that some screens may have an additional fee for
their use. You can see which screens charge additional billing by clicking on a screen listed on the Subscribe to
Mini-Applications screen, and the price for using that screen will display in the Cost per Month per user field,
as described in the following paragraphs. Only employees with proper security can set up which screens are
used in CIM GOLD. See CIM GOLD Security for more information about security.

1. Select “Subscribe to Mini-Applications” from the CIM GOLD tree under Security. The Subscribe to Mini-
Applications screen lists all the screens available to be used.

2. Check the checkboxes next to each screen your institution will use. As you check the boxes, the Cost per
Month per User field at the bottom of the screen will display how much the screen will cost to use. If this
field is blank or empty, there is no charge.

When you click on a screen, a brief description of that screen will display in the Description field at the
bottom of the screen.

3. Once all the screens you want to use have been selected, click <OK>. Those screens will now be available
for you to use in CIM GOLD. You will need to also set up security for employees for each one of the
screens.
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Set Up Comments
Using comments in CIM GOLD is a fast and easy way to track your customers’ history with your institution and
to provide instructions on customer follow-up using standard codes for your institution, instead of typing data.
For detailed information about comments and how to set up the Comments screen, see the <F1> help from the
CIS > Comments screen.
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Set Up Queues
Queues are organized lists of employees’ activities that should be accomplished during the day relating to
customers.

The Queues Screen lists these items that are set up by a supervisor and organizes them into different queues
by date. Typically, these queues list accounts that need action to be taken for a variety of reasons. For
example, queues can be used to call on birthdays, notify customers when deposit accounts reach maturity,
update an account by discussing a customer’s delinquent loan, or even to list customers to solicit for new
loans. 

For information on setting up queues, see the <F1> help for the Contact Queues screen (Queues > Contact
Queues > Contact Queues on the CIM GOLD tree view).



How to ...110

© 2024 DHI Computing Service, Inc.Last updated: 9/9/2024

Search for Help on CIM GOLD
Master Help Search is a compilation file of all the help files in CIM GOLD. Its primary purpose is to search all
existing CIM GOLD help for particular words, phrases, or mnemonics. In general, each screen has one help file,
but there are cases where more than one help file is used. For example, tab pages that are on multiple screens
contain their own help file in addition to a help file for a particular screen. 

Search Using the Master Help File

To search in the Master Help File:

1. Select "Master Help Search" from the Help menu to open the CIM GOLD Master Help File.
2. Click the Search tab.
3. Type the words you want to search for in the text field near the top of the tab, then click <List Topics> or

press <Enter>. Help items found to contain the words you searched for will be listed by title in the list box
below. 

4. Highlight an item in the list box, then click <Display>, press <Enter>, or double-click on the item. The
complete help item will display in the window to the right, and matching words will be highlighted.

Searches can yield up to 500 results; the Search tab contains several options for tailoring searches to increase
the likelihood of finding the precise information you want. In the bottom left-hand corner of the screen are three
checkboxes: Search previous results, Match similar words, and Search titles only. If you want to perform a
search among the results of your previous search, mark Search previous results. If you want your search
results to include any words similar to the word or phrase you typed in the search box, mark Match similar
words. If you only want your search to display results from only the help topic titles and not the actual help
text, mark the Search titles only field. Note: Topic titles are the names of fields, field groups, tabs, and
screens in CIM GOLD.
 
You can also tailor your search using the right arrow button to the right of the text box. Clicking this button
reveals a drop-down list containing the words AND, OR, NEAR, and NOT. These words are inserted between
words you type in the text box. They function as follows:

AND  The search tool will only display results containing both words, not necessarily together.
OR  The search tool will display results containing either word.
NEAR The search tool will display results in which both words appear close to each other.
NOT The search tool will display results in which the first word appears and the second word does not.

Other Features of the Master Help File
The Contents tab contains a tree view that can display the information for each individual help file in CIM GOLD.
This is important for the functionality of the master help screen, but it probably will not be a useful tool for
searching for information. This is because CIM GOLD screens often contain multiple help files, so the individual
help files listed in the Contents tab do not always reflect the full contents of a CIM GOLD screen or tab.

The Index tab contains an alphabetical list of all CIM GOLD help keywords, which closely resemble field names.
This may be useful for users who want to search for help about a particular field using the Index. 

Note: If you select a keyword that is the same on more than one screen, a dialog box will display asking you
which keyword on which screen are you searching for. You can then highlight the desired field and click
<Display> or double-click in the item to view Help for that field. See the following example.

The Index tab allows searching by keywords. A keyword is a word or words relating to a specific help topic.
They are listed in the Index tab for quick and easy reference. To view help for a keyword, highlight the desired
key-word and click <Display> or double-click in the item to view Help for that field.  
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Note: Keywords may contain multiple words, but must contain no spaces between the words.  

The Search tab allows searching by a word or phrase contained within the description of each help topic. The
matched items are listed below the search field. To view help for each item, simply double-click the item and the
help description will be displayed on the right.
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Print from CIM GOLD
Use this feature to print a copy of the CIM GOLD screen you have opened.

Complete the following steps to print a CIM GOLD screen.

1. Click “Print Screen” on the menu bar. The Print dialog box will display.
2. Select the printer and the number of copies you want to print. The Print Range section of this dialog box is

not applicable when printing a screen in CIM GOLD.
3. Click <OK> to print the screen.

Note: To change the paper size, orientation, and paper source, click <Properties> on the Print dialog box and
make the desired changes.

You can also print any list view and grid view data from the right-click pop-up menu.
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Create User-defined Help
User-defined help is help that you create that will be useful for everyone at your institution. You must have
proper security in order to create user-defined help. User-defined help will be available to all employees who have
access to the screen. 

To create user-defined help:

1. Open the screen for which you want to add user-defined help, then select "User Defined Help" from the Help
menu. 

2. In the screen provided, type any help you would like to tie to this screen.
3. You can change the font of the help by clicking <Font>, then selecting what size, font type, and font style

you want the help saved in.
4. Click <OK> and the help will be saved for that screen. You can also print the help by clicking <Print>.  

See also:
Help
How do I use Help?
Search for Help on CIM GOLD
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CIM GOLD Navigation

Because CIM GOLD is a PC-based product, most of the navigating you can do in CIM GOLD will be with your
mouse. If you want to view an account, double-click on the account. If you want to view information under a tab,
click on the tab. If you want to look up an address, click the "Addresses" tab, then double-click the account of
the address you want to look up.

When you right-click on list views and grid views, a pop-up menu will open that will allow you to copy and paste
the information from that field into a word processor or another data-entering application. Also see Right-click
Menu.

Also see Keystrokes for information on access keys, setting up speed keys, and other navigational tips using
your keyboard.

To display a new screen, click on the screen name in the tree-view Navigation section (left-side) of CIM GOLD.
The screen that was being displayed will automatically close and the new screen will display in the Application
section (right side) of CIM GOLD.

See also:
CIM GOLD Screens 
Title Bar  
Menu Bar 
Navigational Bar
Status Bar  
Application  
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CIM GOLD Screens
CIM GOLD allows for a variable number of "plug-in" screens that are listed in a tree-like view in the left window.
Each screen is a mini-application that can be viewed with other screens in the window to the right of the
navigation tree.

To access information from most of these screens, you must first have selected a valid account or customer.
(Some screens are institution-specific rather than account/name specific.) You can look up a valid account or
customer using the Customer Search screen. This is the first screen that opens when you log on to CIM GOLD,
and it is located under CIS in the left tree-view. You can only open this screen if you have security to it. 

You can set up any CIM GOLD screen to be the first screen that opens using the Options menu > Speed Key
Setup screen.
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Title Bar
Located at the top of the CIM GOLD program is the title bar, which displays the name of the application, the
current screen name, the current customer, and the current account number. Selecting another screen will show
the name of that screen for the same customer and account as the current screen.
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Menu Bar
The Menu bar at the top of the screen lists the main menus in CIM GOLD. These main menus will vary
somewhat depending on which screens you are using. See the example below. 

Menu Bar at top of Customer Search screen

Selecting a menu will open a drop-down list that shows functions available within that menu, as shown below. 

To the side of the menu bar at the top of most screens is a navigational menu you can use to quickly open other
accounts. 

See Navigational bar for more information.

Note: These menu options may vary to match the functionality of the screen you are using. For example, if you
are using the Safe Deposit Box System screens, you would not use an Account Number field. Instead, you
would use an Office number and Box number fields (see following example). 

For more information on the functions underneath each menu, see the links below. 

See also:  
File 
< Back
Forward >
Screen History  
Refresh  
Print Screen 
Options 
Help  
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File

The following paragraphs describe each of the functions in the File menu.

Go To Screen This function opens the Enter Screen ID dialog box. Here you can enter a number in
the Screen ID field and click <OK> to display that screen. The screen identification
number is located in the bottom-right of the screen in the status bar.

Initiate CIM Repair Use this function to repair your version of CIM GOLD. Selecting this function causes
the system to install newer .dll files and reload any missing .dll or corrupted files.

It is possible that, if the Install.exe is not found on your PC, the repair will display an
error and will not work. To remedy this, download the Install.exe file from the Internet
again.

CIM Repair will not reload files if the files on your PC have a later version than the
Install files. For example, the DepositHistory.dll has been removed from your PC, and
the AccountDetail.dll (Loan screen) has been updated with an update release of CIM
GOLD. The repair will add the DepositHistory.dll install version to your PC, but will not
replace the update install version of AccountDetail.dll. Only the same date or newer
versions will be reloaded.

Platform Use this function to start, stop, and terminate Platform.

GOLDTeller Use this function to close or terminate GOLDTeller, to reconnect to the Override/Chat
server when communication is lost, and to change file directories.

Get Host Statistics This function opens the Host Statistics dialog box. The Host Statistics dialog box
displays general information about the computer terminal using the CIM GOLD
program. It also displays various response time fields, including Fastest, Slowest,
Difference, and Average. Clicking <Refresh> will cause the system to reload the
dialog box and display current data for that terminal. It may be used to help trouble
shoot problems in screens.

Change Working Set Use this function to toggle between different modes of CIM GOLD: Production,
Monthend, and Testing. Production is the live file, and changing fields in this mode will
change live records and can be used for reporting and research. Monthend mode
displays live files as of the last day of the previous month. No file maintenance is
allowed. Testing mode is a test file for your institution, and changes are saved in test
files and not on live accounts. Each institution has a default test set of 1.

Change Client
Number

Use this function to change client numbers for this PC for General Ledger, Accounts
Payable, Fixed Assets, or Payroll.

Exit This function will close the CIM GOLD program.

< Back

Takes you to the last screen opened, much like a Web browser.  
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Forward >

Once you've used the < Back menu function, this function takes you to the next screen opened.

Screen History

Each line in the Screen History Menu displays a line describing a screen, a customer, and their account
number that you have previously opened. Click on a line in the history to return to that specific screen,
customer, and account number.

Refresh
Click this menu item to update the current CIM GOLD screen with the latest data from the FPS GOLD host
computer.

Print Screen

Click this menu item to send the current screen view to your printer. Printout includes a header with the date,
time, and screen title.  

To print from a CIM GOLD screen:

1. Click "Print Screen" on the menu bar, or select "Print Setup" from the File menu, or press <Ctrl> + <Shift> +
<P>. The Print dialog box will display.

2. Select the printer and the number of copies you want to print. The Print Range section of this dialog box is
not applicable when printing a screen in CIM GOLD.

3. Click <OK> to print the screen. 
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Options

The following functions are found under the Options menu in CIM GOLD.

Speed Key Setup You can assign keyboard keys in CIM GOLD to quickly activate often-used
features, or to go directly to a screen specific to your job. See Set up Speed
Keys for more information. 

Version Report Use this function to print a list of CIM GOLD program modules and version
numbers. You can also save the list and send it to your FPS GOLD banking
consultant. This file helps FPS GOLD employees know which version of CIM
GOLD you’re working with.

Comment Type Setup This function works with the Comments screen so you can specify the types
of comments your institution wants to use. For more information about
comments, see the <F1> help from the CIS > Comments screen.

Comment Shortcut Setup This function works with the Comments screen. You can set up shortcut
codes to be used with comments. For more information about comments,
see the <F1> help from the CIS > Comments screen.

User Preferences Use this function to set up user preferences for CIM GOLD. See User
Preferences for more information about the options available for your use in
CIM GOLD.

Calculate Offline Password Select this function to open the Working Offline dialog box. Enter your user
name and institution number, click <Calculate Backdoor Password>, and
the system will generate a security code you can use to access CIM GOLD
in offline mode. Some offline functions require a valid user name and
password in order to access them. Others, such as printing a version report
or viewing help files, do not need security clearance.

Help

The fields in CIM GOLD have help you can read quickly when you click on a field and press <F1>. The Help
menu at the top of CIM GOLD contains menu options to view other information about CIM GOLD. These options
are explained below.
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About CIM GOLD This option opens the About CIM GOLD dialog box, which shows the
version number, copyright date, and number of sessions in use.

DocsOnWeb This option opens the documentation on the FPS GOLD secure website.
This documentation includes user's guides, details about loan and deposit
reports, and any other documentation that does not belong in F1 help.

Master Help Search This option opens the Master Help dialog box, a compilation of all the help
files used in CIM GOLD. You can use this tool to search all existing CIM
GOLD help for particular words or phrases.

User's Guide This option opens the user's guide you're now reading.

Version Summary This option shows released versions of CIM GOLD and when they were
released. 

Mini-Application Help This option opens a help dialog box that displays functionality and field
descriptions for a screen or field you click on. To open field help, click on a
field on any screen, then select Mini-Application Help from the Help menu,
or press <F1> on your keyboard.

What's New with This Version This option opens the What’s New dialog box that lists any changes made
to the version of CIM GOLD you're using. Changes are listed by screen
name.

What's New (Customer
 Information Manager) This option opens the What’s New dialog box that lists changes made to

the current version as well as past versions of CIM GOLD.

What's New (Current View) This option opens the What’s New screen that lists changes made
specifically to the current screen displayed.

User Defined Help Use this feature to create your own user-defined help for each screen in
CIM GOLD. Only employees with proper security will be able to update
help files. All users can view the user-defined help. The user-defined help
you create will be saved on the FPS GOLD host computer for all CIM
GOLD users at your institution, and the help will be available until you
remove it.
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Navigational bar
To the side of the menu items is a navigational menu you can use to quickly access other accounts. 

Note: These menu options may vary to match the functionality of the screen you are using. For example, if you
are using the Safe Deposit Box System screens, you would not use an Account Number field. Instead, you
would use an Office number and Box number fields (see following example). 

The following table explains each of the navigational icons.

<Previous Screen/Last Screen>

Clicking on the first green left arrow or the right arrow will take you to
the previous screen you opened, or back to the screen you were on
before you clicked the previous screen.

<Beginning of File>

Clicking the left arrow with the vertical line will take you to the very
first available account in descending account number order for your
institution. For example, if you were currently viewing account
number 10, then clicked this icon, you would be taken to account
number 1.

<Previous Account>

Clicking the two-left arrow icon will take you to the previous account
number in descending account number order for your institution. For
example, if you were currently viewing account number 10, then
clicked this icon, you would be taken to account number 9.

<Go to Account Number>

You can use this field to enter the account number, then when you
click the <Go> icon, the system will take you straight to the main
deposit or loan account screen for that account number.

<Next Account>

Clicking the two-right arrow icon will take you to the next account
number in ascending account number order for your institution. For
example, if you were currently viewing account number 10, then
clicked this icon, you would be taken to account number 11.

<End of File>

Clicking the right arrow with the vertical line will take you to the very
first available account in ascending account number order for your
institution. For example, if you were currently viewing account
number 10, then clicked this icon, you would be taken to account
number 999999 (the last account number entered for your institution).



CIM GOLD Navigation 123

© 2024 DHI Computing Service, Inc. Last updated: 9/9/2024

Status  Bar
Located along the bottom of the screen is the status bar:

Status Bar

It displays the following information:

· password expiration information;
· TLLR if GOLDTeller is running;
· the CIM GOLD version number, 
· institution and set number;
· client number;
· user name;
· mode;
· the name of the screen; 
· the version number of the screen; 
· the screen identification number displayed in the Application section (the right side of the screen). 



CIM GOLD Navigation124

© 2024 DHI Computing Service, Inc.Last updated: 9/9/2024

Application
Displays screens with account or customer information. These screens can be installed separately for your
institution or with the main application. CIM GOLD can be tailored to show only those screens your institution
uses. Some screens in CIM GOLD also allow you to make changes to accounts, but proper security must first
be set up for individuals desiring to do this.  



Frequently Asked Questions 125

© 2024 DHI Computing Service, Inc. Last updated: 9/9/2024

Frequently Asked Questions
The following links explain frequently asked questions about CIM GOLD.

I have logged into CIM GOLD, but I can't see the screen I need. Why?

How do I use Help?

Mnemonics are not appearing when I hover over a field. What should I do?

What do I need on my computer to use CIM GOLD?

What are the Fast Go keys in CIM GOLD?

Is there a way to quickly advance through account numbers, safe deposit box numbers, retirement plans,
etc. in CIM GOLD?
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Why can't I see the screen I need?
· Your institution might not have subscribed to that screen. (Options menu > Subscribe to Mini-applications)
· You might not have security to view that screen. (Options menu > Security Setup)
· You might not have the most current version of CIM GOLD. (Version 8.1.0.0 or greater)
· You might need to clear your cache files, then log on to CIM GOLD again. (File Menu > Delete Cache File

and File menu > Delete Current Internal Cache. These two options will clear out your cache and allow you to
reload information directly from the host.)

· You might not have the correct file for that screen stored on your computer. (Contact your FPS GOLD
banking consultant to find out which file you may be missing.)

· If none of the above suggestions work, create a Version Report and e-mail it to your FPS GOLD banking
consultant. (Options menu > Version Report > Save Report to Disk. This will create a text file that you can
attach to an e-mail and send to FPS GOLD.)

Two items affect which screens can be viewed by a user. The first is Subscribe to Mini-Applications under the
Options menu on the menu bar. This option controls what screens are available for use by your institution. If the
box next to the screen name is checked, then your institution has subscribed to that screen. If the box is not
checked, your institution has not subscribed to that screen. 

The second feature that affects which screen a user sees is screen security. Under the Options menu, then
Security Setup, your institution can decide which employees have access to what screens. Possible choices
are Inquiry Only, File Maintenance and Inquiry, or No access to the screen. If you have not been given Inquiry or
File Maintenance access to a screen, that screen name will not appear in the Navigation tree when you have
signed on. Note: Only screens your institution has subscribed to will display in the Security Setup and in the
Navigation tree.

You have security and you subscribe to the screen, but you still cannot view the screen. Why?

Possible reasons include:

1. Do you have the file for the screen? The filename ends in ".dll," such as "AccountDetail.dll." Each screen in
CIM GOLD uses one or more *.dll files to store the look and functionality of the screen. If the .dll for a
particular screen is not included in your files on your computer, the screen will never appear in your
Navigation tree, even if your institution has subscribed to it and you have security to view or maintain it. 

2. The cache file on your computer may be outdated. CIM GOLD uses a cache file to store tables, security,
etc. A version number of the screen security record is also stored in your cache file. If FPS GOLD has
updated the screen security record, then deleting your cache will cause your computer to load that new
version of the security record from the host. If you have further questions, please contact your FPS GOLD
banking consultant for further assistance.
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How do I use Help?
There are many help tools available in CIM GOLD to assist you. Four of them are listed below:

· Field Help – This is used to get help for a specific field. Place the cursor in a field or list box, press <F1>
on your keyboard, or select "Mini-Application Help" from the Help menu.

· Protected Field Help – This is used for fields that do not allow you to place your cursor in that field. Place
your cursor over the field, right-click or left-click to see the field mnemonic. In the box that appears, click
<Close> to close the mnemonic box, or click <Help> to view help for that field.  

· Master Help Search - Select "Master Help Search" from the Help menu. Use the Search tab to type in the
words you want to search for. Results will display below the Search field. Double-click on one of the results
to display help for that result, or highlight the result and click <Display>. You can also use the Contents or
Index tabs to search according to topic or keyword.

· User’s Guide – This is used to get general instructions for using CIM GOLD. Select "User’s Guide" from the
Help menu. Use the Search tab to type in words you want to search for. Results will display below the
Search field. Double-click on one of the results to display help for that result, or highlight the result and
click <Display>. You can also use the Contents or Index tabs to search according to topic or keyword.

See also:
Help
Create User-defined Help
Search for Help on CIM GOLD
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Mnemonics are not appearing
You might not have turned on the User Preference option that allows you to see ToolTip pop-up help.

There is an option in the User Preferences under the Options menu on the menu bar that will turn on the
mnemonics to pop up. When the Enable ToolTip Pop-Up Help field is checked, the mnemonics will pop up for
a field when you hover over that field with your mouse. If that option is unchecked, then pop-up mnemonics will
not appear. 

Note: Some fields throughout the system do not have a mnemonic, thus no mnemonic will appear with mouse
hover. These may be calculated fields or fields that perform a function specific to CIM GOLD. These fields are
not stored in a record; therefore, they do not have a mnemonic.
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What do I need on my computer to use CIM GOLD?
· You must have access to the FPS GOLD host communications facilities. (Required)
· You must have .Net Framework 2.0. (If not, then CIM GOLD Version 2.0.0 or greater will upgrade your .Net

Framework to version 2.0.) (Required)
· You must have a TCP/IP. (Required)
· You should have Windows 2000 or above operating system. (Highly recommended)
· You should have 512 MB RAM, SVGA monitor, and 32 MB free hard disk space. (Highly recommended)

There are certain configurations necessary in order to support CIM GOLD. Those configurations are listed above.
If you have any questions, please contact your client services representative. 

Note: It is strongly suggested that you have the recommended configurations. These will allow for optimal
performance and response time when using CIM GOLD.
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What are the Fast Go keys in CIM GOLD?
The "Fast Go" keys in CIM GOLD are referred to as Speed Keys. They are set up by selecting "Speed Key
Setup" from the Options menu. For more information, see Set up Speed Keys.

If no speed keys are set up for your user on a PC, then the following default speed keys apply:

· Double-click on a name in a list box. This opens the General Information screen in the Customer Relationship
Management section of the navigation tree. 

· Double-click on a deposit account number in a list box. This opens the Account Information screen in the
Deposits section of the navigation tree.

· Double-click on a loan account number in a list box. This opens the Account Information screen in the Loans
section of the navigation tree.

Note: Speed Keys are set up per user per computer.
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Can I quickly move through accounts?
Yes. The Deposit System contains unique options on the menu bar to assist you in navigating between items
on the system: <Beginning of File>, <Previous>, <Go>, <Next>, and <End of File>. <Beginning of File> will go
to the first account number, safe deposit box, retirement plan, etc. on file depending on what screen you are
using when you click <Beginning of File>. 

<Previous> will go to the previous account number on file (smaller number), starting with the account number,
plan number, box number, etc., displayed at the top of the screen. 

<Go> will open a dialog box and allow you to enter an office, account number, and check digit or office number
and box number, etc., of an account, safe deposit box, or retirement plan you want to go to. 

<Next> will display the next account number, plan number, box number, etc., on file (larger number). 

<End of File> will go to the last account number, safe deposit box, retirement plan, etc. on file depending on
what screen you are using when you click <End of File>.

Note: The five options listed above are customizable. Therefore, some screens will have all five options and
some screens will not. Also, the <Go> button name and number of boxes to the left of it will vary according to
what screen you are using. Note that though there may be some variations of these five options per screen, the
general functionality of each option as described above is the same.
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Client Services
When you encounter problems using CIM GOLDTeller, your institution's liaison should contact your institution's
Client Services representative. Use the following link to find information on how to contact your representative.

Client Services User Guide

https://4270517.fs1.hubspotusercontent-na1.net/hubfs/4270517/PDF%20documents/Client%20Support%20Guide/FPS%20GOLD%20Client%20Support%20Reference%20Guide_edited%2012.05.2023%20(002).pdf
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